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安全说明 
本章节包含仪器操作和存储时必须遵照的重要安全

说明。在操作前请详细阅读以下内容，确保安全和

最佳化的使用。 

安全符号 

这些安全符号会出现在本使用手册或仪器上。 
 

警告 
警告：产品在某一特定情况下或实际应用中可能对

人体造成伤害或危及生命 

注意 
注意：产品在某一特定情况下或实际应用中可能对

产品本身或其它产品造成损坏 

 
高压危险 

 
请参考使用手册 

 大地(接地)端子 

 机箱外壳或底座接线端子 

 

勿将电子设备作为未分类的市政废弃物处理。请单

独收集处理或联系设备供应商 
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安全指南 
 

通常 

注意 

 勿将重物置于仪器上 

 避免严重撞击或不当放置而损坏仪器 

 避免静电释放至仪器 

 请使用匹配的连接线，切不可用裸线连接 

 确保 RF 输入准位不超过+30dBm 

 确保 TG 输出端子的反灌功率不超过+30dBm 

 请勿在 TG 输出端输入信号 

 请勿堵塞冷却风扇通风口 

 若非专业技术人员，请勿自行拆装仪器 

 (测量等级) EN 61010-1:2010规定了如下测量等级，该仪器属于等级

II： 

 测量等级 IV：测量低电压设备电源 

 测量等级 III：测量建筑设备 

 测量等级 II： 测量直接连接到低电压设备的电路 

 测量等级 I： 测量未直接连接电源的电路 

电源 

警告 

 交流输入电压: 100V~240V 

 频率: 50/60Hz 

 将交流电源插座的保护接地端子接地，避免电击

触电 

电池 

 注意 

 额定值: 10.8V, 6 cell Li-ion 电池 

 在安装或取出电池组前必须关闭电源拔下电源线 

清洁   清洁前先切断电源 

 以中性洗涤剂和清水沾湿软布擦拭仪器。不要直

接将任何液体喷洒到仪器上 

 不要使用含苯，甲苯，二甲苯和丙酮等烈性物质

的化学药品或清洁剂 
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操作环境  地点: 室内，避免阳光直射，无灰尘，无导电污染

(下注) 

 温度: 5°C~45°C 

 湿度: <90% 

 (污染等级) EN 61010-1:2010规定了如下污染程度。该仪器属于等级

2。 

污染指“可能引起绝缘强度或表面电阻率降低的外界物质，固

体，液体或气体(电离气体)”。 

 污染等级 1：无污染或仅干燥，存在非导电污染，污染无影响

 污染等级 2：通常只存在非导电污染，偶尔存在由凝结物引起

的短暂导电 

 污染等级 3：存在导电污染或由于凝结原因使干燥的非导电性

污染变成导电性污染。此种情况下，设备通常处于避免阳光

直射和充分风压条件下，但温度和湿度未受控制 

存储环境  地点: 室内 

 温度: -20°C~70°C 

 湿度: <90% 

处理 

 

勿将电子设备作为未分类的市政废弃物处理。请单

独收集处理或联系设备供应商。请务必妥善处理丢

弃的电子废弃物，减少对环境的影响 
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英制电源线 

在英国使用该仪器时，确保电源线符合以下安全说明。 
 

注意: 导线/设备连接必须由专业人员操作 

警告: 此装置必须接地 
重要: 导线颜色应与下述规则保持一致: 
绿色/黄色: 接地 

 

蓝色: 零线 
棕色: 火线(相线) 

导线颜色可能与插头/仪器中所标识的略有差异，请遵循如下操作: 

颜色为黄绿色的线需与标有字母 E，或接地标志  ，或颜色为绿色/黄绿色

的接地端子相连 

颜色为蓝色的线需与标有字母 N，或颜色为蓝色或黑色的端子相连。 

颜色为棕色的线需与标有字母 L 或 P，或者颜色为棕色或红色的端子相连。 

若有疑问，请参照本仪器提供的用法说明或与经销商联系。 

电缆/仪器需有符和额定值和规格的 HBC 保险丝保护：保险丝额定值请参照

仪器说明或使用手册。如: 0.75mm2的电缆需要 3A 或 5A 的保险丝。保险丝

型号与连接方法有关，大的导体通常应使用 13A 保险丝。 

将带有裸线的电缆、插头或其它连接器与火线插座相连非常危险。若已确认

电缆或插座存在危险，必须关闭电源，拔下电缆、保险丝和保险丝座。并且

根据以上标准立即更换电线和保险丝。 
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产品介绍 
本章节简要介绍了 GSP-930 的主要特点、包装明

细、首次使用说明以及前/后面板和 GUI 介绍。 

  
 

GSP-930 介绍 ............................................................................................. 8
主要特点 .................................................................................................................... 8

附件 .......................................................................................................... 10
包装明细 .................................................................................................................. 11
 



  GSP-930使用手册 

8 

GSP-930介绍 
GSP-930 是迄今为止固纬推出的最高端的一款频谱分析仪。它具有频

谱、拓扑或光谱的分割视窗显示功能。 

主要特点 
 

性能  9kHz~3GHz 带宽 

 1Hz 分辨率 

 5%的标称 RBW 精度 <750kHz, 8% @>750kHz 

 视频带宽 1Hz~1MHz (10 steps) 

 幅值测量范围: DANL~30dBm (与频率有关) 

 输入衰减: 0 ~ 50dB 

 相位噪声: < -88dBc/Hz@1GHz, 10kHz 

特点  RBW 带宽：10%步进增加 

 三种显示模式: 频谱, 拓扑和光谱 

 分割视窗显示 

 内置 EMI 滤波器 

 自动唤醒功能 

 内置前置放大器 

 门控扫描 

 标记计频器 

 两种操作模式: 频谱和功率计模式 

 SEM 测量 

 ACPR 测量 

 OCBW 测量 

 通道功率测量 

 解调与分析 

 带峰值列表的多种标记功能和特点 
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 序列功能，自动顺序执行预先编辑的操作 

 选配电池操作 

接口  8.4’’彩色 LCD (800600) 

 屏幕菜单图标 

 DVI-I 视频输出 

 RS-232，RTS/CTS 硬件流控制 

 USB 2.0，支持 USB TMC 

 LAN TCP/IP，支持 LXI 

 选配 GPIB/IEEE488 接口 

 IF 输出@ 886MHz 

 耳机输出插孔 

 REF (参考时钟)输入/输出 BNC 接口 

 报警/集电极开路输出 BNC 接口 

 触发/门控输入 BNC 接口 

 RF N-type 输入接口 

 TG 输出接口 

 DC +7V/500mA 输出 SMB 接口 
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附件 
 

标配附件 料号 描述 

 依区域不同 使用手册 

 依区域不同 电源线 

选配 选配序号 描述 

 Opt1.  跟踪源 

 Opt2.  电池(11.1V/5200mAH锂离子电

池) 
 Opt3.  GPIB接口(IEEE 488 bus) 

选配附件 料号 描述 

 PWS-06 USB平均功率传感器(高达

6200 MHz;  
-32~20 dBm) 

 GRA-415 6U机架安装套件 
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包装明细 

使用前请检查包装明细。 
 

打开外箱 
 

 

明细    (每台)  主机 
(可能包含选配的

GPIB, TG 输出) 

 快速使用手册 

 使用手册 CD 

 电源线 x1 (依区域不

同) 

 选配电池组 

 校验证书 
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外观 

GSP-930前面板 

 

LCD display 800600 彩色 LCD 屏幕，显示当前功能软键、频

率、幅度软键和标记信息软键 

Function keys 
F 1

  

~ F 7

 
F1~F7 与屏幕右侧的软键对应 

Main keys 
 

设置中心频率, 起始频率, 停止频率, 
中心频率步进和频率偏移 

 
 

设置扫宽, 选择全扫宽、零扫宽和

最近一次扫宽 
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设置幅值参考电平, 衰减, 前置放大

器控制, 刻度以及其它有关衰减和

刻度的选项 

 
 

自动搜索峰值信号，并以适当的水

平和垂直刻度显示波形 

Control keys 
 

设置分辨率带宽, 视频带宽, 平均类

型以及开启/关闭 EMI 滤波器 

 
 

设置扫描时间和门控时间 

 
 

设置轨迹和相关功能 

 
 

设置视窗模式和基本的显示器属性 

 
 

进入测量选项，如 ACPR, OCBW, 
解调分析, SEM, TOI 和其它高级测

量 

 
 

设置和 Pass/Fail 限制线测试 

 
 

存取, 设置和编辑指令序列 

 
 

设置触发模式 

File 
 

文档选项 

 
 

一键保存状态, 轨迹, 屏幕限制线, 
校准或序列 
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保存轨迹, 状态等，以及保存选项 

 
 

调取轨迹, 状态等，以及调取选项 

Marker 
 

打开/关闭标记，设置标记 

 
 

将光标置于轨迹上 

 
 

启用光标功能，搜索最大和最小峰

值 

State 

 

恢复出厂设置或用户自定义设置 

由远程控制模式转到本地控制 

 
 

切换频谱模式或功率计模式 

 
 

显示系统信息, 设置其它和系统相

关的功能 

Power key 

 

开机/关机 

Scroll wheel 

 

编辑数值, 选择列表选项 
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Arrow keys 

 

增/减值(步进), 选择列表选项 

RF input terminal 

RF  INPUT  50

+30dBm   MAX.
MAX.DC ±50V

 

RF 输入端。接收 RF 输入 

 最大输入: +33dBm 

 输入阻抗: 50Ω 

 最大 DC 电压: ±50V 

 N-type: 母头 

DC power supply  

500mA  MAX.
DC  7V

OUTPUT  

SMB 端口，为选配附件供电 

 DC +7V 

 最大 500mA 

Numeric keypad 
7 8 9

654

1 2 3

/0

BK  SP

Enter

 

数字键盘用于键入

数值和参数。常与

方向键和旋钮一起

使用 

TG output port 

 

跟踪源(TG)输出 

 N-type: 母头 

 输入阻抗: 50Ω 

 输出功率: -50dBm~0dBm 

 最大反向功率: +30dBm 

USB A, Micro SD 
        

USB A 端口, Micro SD 端口，用于

保存/调取设置/文件 
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后面板 

 

RS232 

 

RS232 9 pin DSUB 端口 

IF OUT 

 

SMA IF Out 端口 

DVI-I 

 

DVI 视频输出端口。支持 SVGA 
(800X600) @ 60Hz 

Fan   

Power Socket 

 

电源插座: 
100~240V, 50/60Hz. 



 GSP-930使用手册 

17 

Battery pack 

 

电压: 10.8V 
容量: 5200mAH 

REF IN 

 

BNC 母头参考输入 

REF OUT 

 

BNC 母头参考输出: 
10MHz, 50Ω阻抗 

Security Lock   

ALARM OUT 

 

BNC 母头集电极开路报警输出 

TRIG IN/GATE IN 

 

BNC 母头 3.3V CMOS 触发输入/门
控扫描输入 

Phone 

 

3.5mm 立体声耳机插孔(单声道有线

操作) 

USB B 

 

USB B Device 端口。USB 1.1/2.0 

LAN 

 

RJ-45 10Base-T/100Base-Tx 
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显示 

 

Reference level 显示参考电平。详细信息见 43 页 

Attenuation 显示输入信号的垂直档位(衰减)。详细信息见 44 页 

Date/Time 显示日期和时间。详细信息见 101 页 

Marker information 显示标记信息。详细信息见 80 页 

LXI icon 显示 LXI 连接状态。详细信息见 183 页 

Function menu 对应屏幕右侧 F1~F7 功能键 

Sweep settings 

 

显示扫描状态。详细信息见 62 页 
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Trigger settings 

 

显示触发状态。详细信息见 75 页 

Pre-amp settings 

 

显示前置放大器状态。详细信息见

45 页 

Trace and detection 
settings 

 

显示每条轨迹类型和检测模式。详细

信息见 68 页 

Status Icons 显示接口状态, 电源状态和报警状态等。见 20 页状

态图标介绍章节 

Frequency/ 
Bandwidth settings 

显示起始频率, 中心频率和停止频率, RBW, VBW, 扫
宽和扫描设置 

Entry/Message area 显示系统信息, 错误信息和输入值/参数 

Trace and waveforms 主屏显示输入信号, 轨迹(见 68 页), 限制线(见 150
页)和标记位置(见 80 页) 
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状态图标介绍 
 

PreAmp 
 

表示开启前置放大器 

AC  
 

表示交流供电 

AC Charge 
 

表示交流电源正在为电池充电 

Alarm Off 
 

表示已关闭报警输出 

Alarm On 
 

表示已开启报警输出 

Amplitude Offset 
 

开启幅值偏移。当使用与幅值有关的

功能时，出现此图标: 
参考电平偏移 
幅值校准 
输入 Z = 75Ω 
输入 Z cal >0 

Battery indicator 
 ~  

电池充电 

Bandwidth Indicator 
 

表示 RBW 或 VBW 设置处于手动模

式 

Average 
 

已开启平均功能 

External Lock 
 

表示系统被锁，涉及到外部参考输入

信号 

External Trigger 
 

表示正在使用外部触发信号 
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Math 
 

表示正在使用轨迹运算 

Sequence Indicator 
 

表示正在执行一个序列 

Sweep Indicator 
 

表示扫描时间被手动设置 

Tracking generator 
   

表示开启跟踪源 

TG Normalization 
 

表示跟踪源已被校准 

Wake-up clock 
 

表示开启唤醒时钟 

USB 
 

表示已识别出 U 盘 

Micro SD 
 

表示已识别出 micro SD 卡 
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首次使用说明 
首次操作仪器，如倾斜站立、插入电池、仪器供电、设置内部时钟、

唤醒时钟、更新固件和重建默认设置时，请按照如下步骤执行。最后

向您介绍一些常规操作。 

倾斜站立 
 

描述 

 
 

GSP-930 有两个可调橡胶支脚，可以将仪器调整

到两个预设位置 

直立位置 向仪器底端收拢支

脚，仪器直立 

 

倾斜位置 向后搬动支脚，仪器

倾斜站立 
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插入电池 
 

描述 GSP-930 提供选配电池组，插入电池前必须关闭

电源，断开 AC 电源插座 

步骤 1. 关闭电源，断开 AC 电源 

 2. 打开电池盖 

 3. 按下图插入电池 

 4. 合上电池盖 

显示图标 
  

当 GSP-930以电池供电时，屏幕显示电池

图标 

插入图示 
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供电  
 

步骤 1. 将 AC 电源线插入电源插座 

 2. 电源开关呈蓝色，表示 GSP-930 处于待机状态

 

 3. 按此按钮开启 GSP-930 

 4. 开机后电源开关变为橙色 

 

 注意 
GSP-930完全开机需要大约 1.5分钟 
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关机 
 

描述 GSP-930 有两种关机方式: 正常关机和强制关

机。 

正常关机方式保存系统状态并结束所有运行中的

进程。下次开机时可以继续使用该状态。 

强制关机方式仅最低限度的保存状态。 

正常关机 按下电源开关。系统自动依序处理电源关机过

程: 

 
 保存系统状态 

 按顺序关闭未处理进程 

 关闭 LCD 背光灯 

 系统进入待机模式(电源开关由橙转蓝) 

 注意 
此过程大约持续 10 秒时间 

强制关机 按下电源开关并保持 4 秒时间，直至系统关闭且

电源开关变成蓝色 

 注意 
强制关机方式可能导致仪器在下次开机时自检时

间变长 
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设置日期, 时间和唤醒时钟 
 

描述 GSP-930 使用唤醒时钟功能可以自动设置开机时

间，有利于减少稳定等待时间。 

系统时间 例如: 设置系统日期 2012, 3, 1 

1. 按 >时间日期[F4]>设置日期[F1]>年[F1] 

2. 按 2012>输入[F1] 

3. 按月[F2]>3>输入[F1] 

4. 按日[F3]>1>输入[F1] 

5. 按返回[F7] 

 注意 
系统日期显示在屏幕上方 

系统时间 例如: 设置系统时间 9.00 AM 

1. 按 >时间日期[F4]>设置时间[F2]>小时[F1] 

2. 按 9>输入[F1] 

3. 按分钟[F2]>0>输入[F1] 

4. 按秒[F3]>0>输入[F1] 

5. 按返回[F7] 

 注意 
系统时间显示在屏幕上方 
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系统唤醒时钟 例如: 设置 GSP-930 开机时间 9.00 AM 

1. 按 >时间日期[F4]>唤醒时钟编辑[F3]>选择
时钟[F1] 

2. 按时钟 1 [F1]选择时钟(1 ~ 7) 

3. 按状态[F2]打开/关闭时钟 

4. 按小时[F3]>9>输入[F1]. 

5. 按分钟[F4]>0>输入[F1]. 

6. 按[F5]选择连续. (重复)或单次 

7. 按连续设置[F6]选择日期 

8. 按返回[F7]保存唤醒时钟设置 

 注意 
CR2032电池给时钟电路供电。如果系统时间/唤
醒时钟不能再更新，请更换时钟电池。见 193页 
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固件更新 
 

描述 允许用户更新 GSP-930 固件。请登陆 GW 
Instek 网站查询最新固件或联系您当地经销商。 

系统版本 更新固件前，请检查固件版本 

 1. 按 >系统资讯[F1] 

2. 屏幕显示固件列表 
 

 

 

 3. 按任意键退出 

 4. 将带有新固件的 U 盘或 Micro SD 卡插入前面板

适当位置。固件文件存档于“gsp930”目录下 

 5. 按 >更多 1/2[F7]>升级[F3] 

 6. 频谱分析仪自动搜寻 U 盘固件并立即更新。更

新完成后，屏幕底部显示“Upgrade is finished”
和“Rebooting” 
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 7. 系统自动重启 

 注意 
更新过程需要几分钟 

恢复默认设置 
 

描述 前面板预设键可以一键恢复出厂默认设置或用户

定义设置。默认情况下，预设键用于恢复出厂默

认设置。 

详情请见 104 页。 

步骤 1. 按  

2. 频谱分析仪调取预先设置 
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常规操作 

下述内容贯穿整个使用手册。仔细阅读，掌握 GSP-930 菜单系统和

前面板键的基本操作。 
 

软菜单键 屏幕右侧 F1~F7 功能键直接对应它们左侧的软

菜单键。

Soft-menu keys

F1 ~ F7 function keys

 

输入参数值 

 
 
使用数字键盘输入数值或通过旋钮增加/减少数

值 

切换状态 

 
 
按此菜单键切换状态 
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切换状态&输入参

数 

 

切换自动或手动状态。在手动模式时，需要手动

编辑参数值。使用数字键盘输入新值或使用旋钮

增加/减小当前值 

子菜单 

 
 
 按此键进入子菜单 

子菜单选择参数 

 
 
进入子菜单选择参数 

激活功能 

 
 
按此键激活功能。功能开启后此菜单键变亮 
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参数输入 

 
 
输入参数可能会用到数字键盘、旋钮和方向键。 

使用数字键盘 使用数字键(0~9), 小数点(.)和符号键(+/-)输入数

值。软菜单键用于选择单位。 
 
编辑完成后屏幕下方显示参数值。 
 

 

退格键 使用退格键删除前一个字符或数字 

使用旋钮 使用旋钮改变当前值。顺时针增加，逆时针减

小。 

方向键 使用方向键选择参数或通过粗调改变数值。向左

减小数值, 向右增加数值 
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频率设置 

中心频率 
 

描述 设置中心频率并显示在屏幕中心位置。 

操作 1. 按 >中心频率[F1]，输入频率和单位 

 范围:  
分辨率: 
默认: 

0kHz~3GHz  
1Hz 
1.5GHz 

显示 Center frequency

Set Center Frequency  
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起始和截止频率 
 

描述 设置扫宽的起始和截止频率 

操作 1. 设置起始频率, 按 > 起始频率[F2]输入频率

和单位 

2. 设置停止频率, 按 > 截止频率[F3]输入频率

和单位 

 范围: 
分辨率: 
默认起始频率: 
默认截止频率: 

0kHz~3GHz 
1Hz 
0Hz 
3GHz 

显示 

 

 注意 
设置扫宽时可能导致起始和截止频率发生变化。 
截止频率必须大于起始频率(因为扫宽  0), 否则扫

宽将自动设为 100Hz 
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中心频率步进 
 

描述 中心频率步进功能用于设置中心频率步进。 
 
当使用方向键改变中心频率时, 每按一下都将移

动中心频率，步进大小由中心频率步进功能设

定。 
 
在自动模式下, 中心频率步进等于扫宽的 10% (1 
div)。 

操作 1. 按 > 中心频率步进[F4]设置自动或手动中

心频率步进模式 

2. 若选择手动模式, 需设置步进的频率和单位 

 手动范围: 
自动范围: 

100Hz~3GHz 
扫宽的 1/10 

显示 
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频率偏移 
 

描述 频率偏移功能允许对中心频率、起始和截止频率

以及标记频率增设一个偏移量。偏移值不影响显

示轨迹。 

运行 1. 按 >频率偏移[F5]设置偏移值 

中心频率、起始频率、截止频率和标记频率也相

应更新。 

 偏移范围: 0Hz~100GHz 

显示 
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扫宽设置 

扫宽 
 

描述 扫宽功能用于设置扫描的频率范围。扫描以中心

频率为中心。 
 
设置扫宽将改变起始和截止频率。 

操作 1. 按 > 扫宽[F1]输入扫宽频率范围和单位 

 范围: 
分辨率: 
默认扫宽: 

0kHz~3GHz 
1Hz 
3GHz 

显示 

 



 GSP-930使用手册 

41 

全扫宽 
 

描述 将扫宽设为全频率范围。 
 
此功能分别将起始和截止频率设为 0Hz 和

3GHz。 

操作 1. 按  > 全扫宽[F2] 

零扫宽 
 

描述 零扫宽功能将扫描频率范围设置在 0Hz，将起始

和截止频率等同于中心频率。零扫宽功能在中心

频率下测量输入信号的时域特性。水平轴代表时

域。 

操作 1. 按 > 零扫宽[F3] 
 
扫宽相应改变。 

显示 

 
例如: 调幅 
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 注意 
在零扫宽设置下，TOI, SEM, CNR, CTB, CSO, ACPR, OCBW, 
phase Jitter和 NdB等测试功能不可用。 

上次扫宽 
 

描述 返回上一次扫宽设置 

操作 1. 按 > 上次扫宽[F4] 
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幅值设置 
垂直显示刻度由参考电平幅值、衰减、比例和外部增益/损耗决定。 

参考电平 
 

描述 以电压或功率为单位定义顶部格线处幅值的绝对

电平值。 

操作 1. 按 > 参考电平[F1]输入参考电平幅值和单

位 

 范围: 
单位: 
分辨率: 

-120dBm ~ 30dBm  
dBm, W, V, dBmV, dBuV  
1dBm 

显示 Reference LevelRef Level reading
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衰减 
 

描述 可以通过自动(Auto)或手动(Man)模式完成输入

信号的电平衰减设置。当衰减设置为 Man 时，

输入衰减能调整成 1dB 步进。 

操作 1. 按 > 衰减[F2]选择自动或手动 

2. 如果选择手动，需要输入衰减电平和单位 

 范围: 
单位: 
分辨率: 

0dBm ~ 50dBm 
dBm 
1dB 

显示 
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刻度/格 
 

描述 当刻度设为对数时，设置垂直每格的刻度大小。 

操作 1. 重复按 > 刻度/格[F3]选择垂直刻度大小 

 刻度大小: 10, 5, 2, 1 

显示 

 

 注意 
仅当刻度设为 Log (对数)时才可以选择刻度/格功

能 

刻度类型 
 

描述 以线性或对数单位设置垂直刻度。 
默认情况下线性刻度为 V，对数刻度为 dBm。 

操作 1. 按 > 刻度类型[F4]设置对数或线性垂直刻

度 

 注意 
即使刻度单位发生改变(如 dBm → volts)，垂直刻度

类型仍保持不变 

显示刻度 
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描述 打开/关闭垂直刻度。每个刻度的单位都与参考

电平的设置单位相同。 

操作 1. 按 >刻度[F5]打开或关闭显示 

2. 按刻度位置[F6]切换刻度位置 

 刻度位置: 左, 中, 右 

显示 

Scale 
Left

 
默认显示在屏幕左侧 



 GSP-930使用手册 

47 

垂直刻度单位 
 

描述 改变线性或对数刻度的垂直单位。 

操作 1. 按 > 更多[F7]>Y 轴单位[F1]选择单位 

2. 单位相应改变 

 单位: dBm, dBmV, dBuV, W, V 

参考电平偏移 
 

描述 设置一个参考电平偏移值，补偿由外部网络或仪

器引起的损失或增益。 
偏移值不影响输入衰减或屏幕上的轨迹。 
此设置将改变参考电平读值、刻度读值和标记读

值。 

操作 1. 按 > 更多[F7]>电平偏移[F2]设置偏移值和

单位 

2. 若取消偏移设置，将参考偏移设为 0 dB 

 范围: 0dB ~ 50dB 

显示图标 
  

AMP图标显示在屏幕底部 

例如: 
 

 
设置参考电平偏移前(offset: 0dB) 
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Ref: 10dBm

Reference level 
offset: 10dB

 
设置参考电平偏移后(offset: 10dB) 

幅值校正 
 

描述 通过改变特定频率的幅值，调整频谱分析仪的频

率响应。可以使频谱分析仪补偿某一频率下由外

部网络或仪器引起的损失或增益。 

范围 校准设置: 5 组，每组 30 个校准点 
幅值: 每个校准点-40dB~+40dB 
幅值分辨率: 0.1dB 
频率: 9kHz~3GHz 
频率分辨率: 1Hz 

显示 

 
例如: 上图显示了幅值校正功能如何对特定频率

下的损失或增益进行补偿 

创建校正设置 
 



 GSP-930使用手册 

49 

描述 GSP-930 可以创建和编辑 5 组校正点。校正点及

对应值以列表形式显示。 

操作 1. 按 > 更多[F7]>幅度校正[F3]> 选择校正集
[F1]选择一个需要编辑/创建的校正集 

 校正集: 1~5 

 2. 按编辑[F3] 

屏幕分为两部分。上部显示波形，下部显示全部

校正点

Spectrum display

Correction points

Frequency of 
selected point

 

 3. 按点[F1]输入需要编辑的点 

 点: 1~30 

 4. 按频率[F2]输入点的频率 

 
按增益偏移[F3]输入点的幅值。单位与垂直刻度

单位保持一致 
 
所设点的频率值显示在下方校正列表里 
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 5. 重复 2~4 步设置其它校正点 

6. 按删除点[F6]删除所选校正点 

7. 按返回[F7]>保存[F5]保存校正设置 

 注意 
校正点自动依频率排序(由低→高)。 
启动前必须首先保存校正组。 
 
校正列表里的频率值为约值，实际频率显示在频

率软键位置 

启动/关闭幅值校正 
 

描述 可以启动任意一组校正。 

激活校正 1. 按 > 更多[F7]>幅度校正[F3]> 选择校正集
[F1]选择一个校正集 

校正集: 1~5 

2. 按校正功能[F2]启动校正 

关闭校正 1. 按 > 更多[F7]>幅度校正[F3]> 校正功能
[F2]关闭校正 

删除校正设置 
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操作 1. 按 > 更多[F7]>幅度校正[F3]> 选择校正集
[F1]选择需要删除的校正集 

 校正集: 1~5 

 2. 按删除幅度校正[F6]删除 

保存校正设置 
 

操作 1. 按 >按类型[F2]> 幅度校正[F5] 

2. 按数据源[F3]选择校正集 

校正集:               1~5 

3. 按保存至[F1]选择存储位置 

位置:                   寄存器, 本地, USB, SD 

4. 按名称[F1] 输入存储名称 

5. 按立即保存[F3] 

6. 校正组将保存至所选位置。更多存储和调取信息

见 161 页 
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调取校正设置 
 

操作 1. 按 > 按类型[F2]> 幅度校正[F5] 

2. 按数据源[F3]选择校准集 

校准集:                      1~5 

3. 召回[F1]选择调取位置: 

 位置: 寄存器, 本地, USB, SD 

 4. 按立即召回[F1] 

5. 调取当前校准集。更多存储和调取信息见 161 页 

输入阻抗 
 

描述 设置 75Ω或 50Ω输入阻抗。 

操作 1. 按 > 更多[F7]>输入阻抗[F4]切换输入阻抗 

 档位: 75Ω, 50Ω 
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校准输入阻抗 
 

描述 通过外部阻抗转换器模块(选配附件 ADP-101)，
可将仪器阻抗由 50Ω转换到 75Ω。此时会引起外

部损耗，使用输入阻抗补偿功能的阻抗偏移设置

能够对其进行补偿。 

 注意 
仅当输入阻抗为 75Ω时，才可以使用输入阻抗补

偿功能。 

操作 1. 按 > 更多[F7]>输入阻抗补偿[F5]设置阻抗

偏置 

范围：                            0dB~+10dB 

分辨率：                        1dB 

显示图标 
  

当输入输入阻抗补偿0dB
时，AMP图标显示在屏幕

下方 

   

使用内置前置放大器 
 

描述 内置前置放大器可以放大整个频率范围内微弱的

输入信号，如 EMI 测试信号。内置前置放大器

具备 20dB 的标称增益。 
 
在自动设置状态下，当参考电平小于-30dBm
时，前置放大器将自动开启。当参考电平大于-
30dBm 时，前置放大器关闭。 

前置放大器设置成绕开将强制关闭前置放大器。 
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操作 1. 按 > 更多[F7]>前置放大器[F6]切换前置放

大器状态 

 范围: 自动, 绕开 

显示图标 

  

Pr-amp图标表示前置放大器已开启。 

例如: 
 

 
 

 注意 
当开启前置放大器时，衰减保持在 0dB (如衰减 = 
0dB) 
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自动设置 
自动设置功能搜索分两阶段(全扫宽& 0Hz - 100MHz 扫宽)的峰值信

号，找出最大幅值并显示在屏幕上。 

使用自动设置 
 

操作 1. 按 > 自动设置[F1] 

自动设置范围 幅值: 
扫宽: 

-80dBm ~ +20dBm 
100Hz ~ 3GHz 

例如: 

 
自动设置前 
 

 
自动设置后 
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 注意 
当使用自动设置功能时，RBW, VBW和扫描设置被

重置为自动。 

限定自动设置的垂直搜索范围 
 

描述 通过设置幅值下限，自动设置功能将忽略小于设

置基准的信号。 

操作 1. 按 > 振幅下限[F2]由自动切换为手动 

2. 输入幅值下限值和单位 

 范围: −80~+20dBm 

 注意 
幅值单位设置见 45页 

限定自动设置的水平搜索范围 
 

描述 改变显示器的扫宽限制，更方便检视自动设置结

果。自动设置后默认扫宽为 3MHz。 

操作 1. 按 > 扫宽[F3]由自动切换为手动 

2. 输入扫宽 

 范围: 100Hz~3GHz 
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带宽/平均设置 
BW/Avg 键设置分辨率带宽(RBW)、视频带宽(VBW)和平均等功

能。分辨率、扫描时间和平均互为交换关系，应慎重设置。 

分辨率带宽设置(RBW) 
 

描述 RBW (分辨率带宽)定义 IF (中频)滤波器的带宽，

用于互相分离信号峰值。RBW 越窄，分离相近

频率信号的能力就越大。但在指定扫宽下会导致

扫描时间更长(屏幕更新的次数减少)。 

操作 1. 按 > 分辨率带宽[F1]，将分辨率带宽设为

自动或手动 

2. 设置手动模式的分辨率带宽和单位 

 模式: 
频率范围(3dB): 
 
频率范围(6dB): 

自动, 手动 
10Hz~3kHz (1-3-10 步进) 
10kHz~1MHz (10%步进) 
200Hz, 9kHz, 120kHz 

显示图标 
  

当 RBW设为手动模式时，屏幕底部显示

BW图标 

 注意 
若 RBW设置带星号(*)，代表使用了-6dB带宽的滤

波器。 
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视频带宽设置(VBW) 
 

描述 VBW (视频带宽)定义了画面轨迹的平滑度。

RBW 与 VBW 一起决定了从周围噪声或邻近峰

值中处理目标信号的能力。 

操作 1. 按 > 视频带宽[F2]，将视频带宽设为自动

或手动 

2. 设置手动模式的视频带宽和单位 

 模式: 
频率范围(3dB): 

自动, 手动 
1Hz~1MHz (1-3-10 步进) 

显示图标 
  

当 VBW设为手动模式时，屏幕底部显示

BW图标 

视分带宽比(VBW/RBW) 
 

描述 VBW/RBW 功能用于观察视频带宽和分辨率带

宽的比值。 
 
VBW/RBW 比值随 RBW 与 VBW 的设置改变，

分别见 57 & 58 页。 

观察 VBW/RBW 1. 按  

2. 比值显示在视分带宽比[F3]软键上 
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显示 
VBW/ RBW

Ratio

 

提示 掩藏在底噪中的信号若要平滑噪声，必须保证其

比值小于 1。 
 
较大频率分量的信号应保证其比值等于或大于

1。 

平均波形 
 

描述 平均功能在波形显示前将波形平均指定次数。虽

然此特点能平滑噪声准位，但却以降低屏幕更新

率为代价。 

操作 1. 按 > 平均化[F4]开启或关闭平均功能 

2. 设置平均数 

 范围: 
默认值: 

4 ~ 200 
20 

显示图标 
  

当开启平均功能时，屏幕底部显示 AVG图
标 
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例如: 

 
平均: 关闭 
 

 
平均: 开启(20) 
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平均类型 
 

描述 平均类型功能决定 GSP-930 如何定义平均值。 

对数功率平均: 以对数刻度平均波形点； 

电压平均: 以线性电压刻度平均波形点幅值 

功率平均: 以单位为瓦特的对数刻度平均波形点 

操作 1. 按 > 平均类型[F5]选择平均类型 

 范围: 
 
默认值: 

对数功率, 电压平均, 功率

平均 
对数功率 
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EMI滤波器 
 

描述 内置 EMI 滤波器用于特定情况下的测量，如

EMI 平均侦测，比标准设置要求更高的灵敏度。

开启后，出现-6dB 的分辨率带宽滤波器并在分

辨率带宽右上角显示一个星号(*)。 

当任何一个测量功能开启时(详细内容见 106
页)，EMI 滤波器自动关闭。相反，如果 EMI 滤
波器开启，任何测量功能都将关闭。 

操作 1. 按 > 电磁干扰滤波器[F6]开启或关闭 EMI
滤波器 

扫描 
GSP-930 有一个扫描选项，包括设置扫描时间和扫描模式(持续, 单
次)，同时也提供了门控扫描模式。 

扫描时间 
 

描述 扫描时间定义了系统"扫描”当前扫宽所花费的时

间。注意，扫描时间和 RBW/VBW 相互权衡。

扫描时间越快，更新显示越频繁，但使得 RBW
和 VBW 越宽，从而降低了分离邻近频率信号的

能力。 

操作 1. 按 > 扫描时间[F1]切换自动或手动扫描时

间 

2. 设置手动模式的扫描时间 



 GSP-930使用手册 

63 

 模式: 
范围: 
 
分辨率: 

自动, 手动 
22ms ~ 1000s (span>0Hz) 
50us ~ 1000s (span=0Hz) 
10us 

显示图标 
  

当设为手动扫描模式时，屏幕底部显示 
SWT图标 

单次扫描 
 

描述 用于执行一次单次扫描。按单次扫描，GSP-930
在完成一次单次扫描后停止。 

操作 1. 按 > 单次[F2]进入单次扫描模式 

2. 再按单次[F2]执行一次单次扫描 

显示图标 

  

当设为单次扫描模式时，屏幕右侧显示

Sweep Single图标 

 注意 
必须等待单次扫描完成后才能再按单次扫描键。 
 
若在频谱分析仪扫描时改变设置，将立即重新开

始扫描。 
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连续扫描 
 

描述 GSP-930 具备两种主要的扫描模式: 单次扫描和

连续扫描。连续模式将持续更新扫描。 

操作 1. 按 > 连续扫描[F3]进入连续扫描模式 

显示图标 

  

当设为连续扫描模式时，屏幕右侧显示

Sweep Cont图标 

 注意 
除非将扫描模式更改成单次扫描或系统处于等待

触发状态，GSP-930将持续进行扫描 

门控扫描概述 
 

描述 门控扫描模式允许触发信号决定频谱仪何时开始

扫描。此模式对以脉冲式开启或关闭为特征的信

号非常有用。如：RF 突发传输系统或测量传输

突发之间的杂散噪声电平。 

概述 1. 触发信号一定要与输入信号的周期同步(见下图
RF burst) 

2. 门控起始时间由触发信号的上升沿或下降沿以及

延迟时间共同决定 

3. 门控结束时间由门控时间长度决定 

4. 门控扫描不应设置在传输开始或结束 
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例如: 上述图表说明了输入触发、输入信号以及

与输入信号有关的门控扫描之间的关系 

 注意 
请考虑 RBW的稳定时间。若将延迟时间设置过

短，可能会造成 RBW滤波器的处理时间不够 
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使用门控扫描模式 
 

连接 1. 将一个触发信号(3.3v CMOS)连接到后面板

GATE IN 端子 

 

操作 1. 按 > 门信号延迟[F5]设置门控延迟时间 

2. 按 > 栅极长度[F6]设置门控时间长度 

3. 按 > 栅控扫描模式[F4]启动模式 

 门控延迟: 
门控时间长度: 

0s ~ 1000s 
10us ~ 1000s 

显示图标 

  

当开启门控扫描时，Sweep Gated图标显示

在屏幕上 



 GSP-930使用手册 

67 

例如: 
 

门控扫描模式关闭时，FSK调制信号的频谱图： 

 
 
同一个信号，当门控扫描开启时，仅输出期望频

率： 

  

 注意 
开启门控扫描前，必须首先设置门信号延迟和栅

极长度。 
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轨迹 
GSP-930 一次可以设置 4 种轨迹参数。各轨迹由不同颜色表示且随每

次扫描更新。 

选择轨迹 
 

描述 各轨迹(1, 2, 3, 4)由不同颜色表示。开启后，屏幕

左侧显示带轨迹颜色和功能的图标。从轨迹菜单

进入设置/编辑参数。 

 轨迹颜色: 1: 黄色 
2: 紫色 
3: 蓝色 
4: 橘色 

轨迹类型 轨迹类型决定轨迹数据是如何存储或操作的。频

谱分析仪根据设定的轨迹类型更新轨迹。 

 清除和写入 每次扫描都会更新轨迹 

 最大值保持/  
最小值保持 

如果扫描出幅值更高的/更低

的，轨迹点随即更新，否则维持

原来的最大/最小值 

 查看 查看模式将保持所选轨迹并停止

更新轨迹数据。按查看[F5] 将显

示由保存隐藏[F6]键清除的轨迹

数据 

 Blank 清除所选轨迹并存储轨迹数据。

按查看[F5]恢复轨迹数据 



 GSP-930使用手册 

69 

显示图标 

Clear & Write

Hold Max

View

Blank

Trace 1

Trace 2

Trace 3

Trace 4
 

操作  1. 按 > 选择轨迹[F1]选择轨迹编号 

 轨迹: 1, 2, 3, 4 

 2. 选择轨迹类型: 

 清除&写入[F2] 
最大保持[F3] 
最小保持[F4] 
查看[F5] 
保存隐藏[F6] 

 

 注意 
轨迹 2, 3和 4默认设置为保存隐藏 
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轨迹运算 
 

描述 完成两组轨迹(TR1, TR2)的数学运算并将结果保

存在当前所选轨迹。它也可以用作轨迹转移。 

运算功能 功率差 TR1 幅值减去 TR2 幅值。TR1
和 TR2 的数据被转换成单位为

瓦特，运算完后再被转换成
dBm 

 对数差 TR1 幅值减去 TR2 幅值加上对

数参考量。TR1 和 TR2 的数据

单位为 dBm。相减后的轨迹单

位为 dB。当结果加上对数参考

量后，单位为 dBm 

 对数偏移 TR1 轨迹增加一个参考量 

操作 1. 按 > 更多[F7]>迹线运算[F1] 

 2. 按 TR1[F1]选择第一个轨迹: 

 TR1:  Trace 2, Trace 3, Trace 4 

 3. 按 TR2[F2]选择第二个轨迹: 

 TR2:  Trace 2, Trace 3, Trace 4 

 4. 选择轨迹运算功能: 

 功率差[F3] 
对数差[F4] 
对数偏移[F5] 

 

 5. 如果选择对数差，设置参考电平和单位 
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 对数差参考范围: 
对数差参考单位: 
 

-120dBm ~ 30dBm 
dBm, W 

 6. 如果选择对数偏移，设置偏置电平和单位 

 对数偏移范围:  -50dB~+50dB 

 7. 按关闭[F6]关闭轨迹运算 

显示图标 
 

开启轨迹运算时显示 Math图标 

轨迹侦测模式 
 

描述 轨迹上每个点的多个采样数据的集合体，称为采

样池。每个轨迹点的实际值由各采样池中的采样

侦测器决定。 

各轨迹(1, 2, 3, 4)可以使用不同的侦测模式。 

侦测模式 自动 根据所有采样值，自动选择一个适

当模式 

 标准检波 当信号准位持续增加或减少时，侦

测正向峰值。否则，侦测模式在正

向峰值和负向峰值间切换。有利于

挑出突发现象，避免太多噪声 

 正峰值检波 通过选择各采样区中每点的最大峰

值，侦测正向峰值信号。该模式有

利于正弦曲线信号 

 负峰值检波 通过选择各采样区中每点的最低峰

值，侦测负向峰值信号。该模式不

推荐幅值测量 
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 取样 任意选择采样区内值。有利于侦测

噪声信号 

 平均 计算采样区中所有采样点的平均值 



 GSP-930使用手册 

73 

自动侦测器选择

方式 
如下是一个自动模式的侦测器选择流程图。 
 

 

操作 1. 按 > 更多[F7]>检波器[F2] 

2. 选择轨迹侦测模式: 

 自动[F1] 
标准检波[F2] 
正峰值检波[F3] 
负峰值检波[F4] 
取样[F5] 
平均[F6] 
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 3. 屏幕返回轨迹(Trace)菜单 

显示图标 

 

标准检波 

 

平均图标 

 

 

正峰值检波图

标 

 

负峰值检波图

标 

 

 

取样图标 

 

平均图标 
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触发 
频谱分析仪在触发功能设置后触发捕获波形，包括频率、幅值和延

迟。与默认的内部信号不同，外部触发信号可以用于特殊情况。 
 
相关章节如下: 

 

 自由运行模式 → 见 75 页 

 激活视频触发 → 见 75 页 

 激活外部触发 → 见 77 页 

 选择触发模式 → 见 78 页 

 设置触发延迟时间 → 见 79 页 

选择触发类型 

自由运行模式 
 

描述 自由运行模式下，不使用触发条件捕获所有信

号。 

自由运行模式 1. 按 > 自由运行[F1]进入自由运行模式 

激活视频触发 
 

操作 设置视频信号的视频触发准位。当视频信号的电

压准位超过*视频触发准位，将产生一个触发信

号。 
*上升视频沿 
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参数 视频边沿: 决定视频触发的极性 
 
正向: 在触发频率下，信号电压超

过视频准位 
 
负向: 在触发频率下，信号电压低

于视频准位 

 视频电平: 触发电压准位 

 触发频率: 设置开始触发的频率 

操作 1. 按 >触发状态[F2]>视讯[F1] 

 2. 按视频边缘[F1]选择触发沿 

 范围:  正向, 负向 

 3. 按视频电平[F2]，设置视频电压触发电平 

 触发电平:  (-120dBm~+30dBm) +参
考电平偏置 

 4. 按触发频率[F3]选择频率。在此频率下，频谱分

析仪开始检测触发条件 

 频率:  0-3GHz+频率偏置 

 注意 
触发返回自由运行，视频触发模式关闭 
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激活外部触发 
 

描述 当外部触发信号接入后面板 TRIG IN 端子时，可

以使用外部触发功能。外部触发信号分上升沿或

下降沿。 

 触发器: 3.3V, CMOS 

操作 1. 按 >触发状态[F2]>外部边缘[F2]选择触发

沿: 

 Pos: 
Neg: 

上升沿 
下降沿 

 2. 将外部触发信号接入后面板 TRIG IN 端子 

 

 3. 按马上行动[F5]开启外部触发 

 4. 扫描开始前，系统等待匹配的触发条件 

显示图标 

 

当开启外部触发时显示 EXT Trigger图标 

 注意 
如果改变任何参数设置，如扫宽或幅值，触发将

恢复至自由运行模式 



  GSP-930使用手册 

78 

选择触发模式 
 

描述 自由运行模式下，所有信号均被捕获且不使用触

发条件。 

模式 正常: 频谱分析仪捕获每一个满足触发条

件的信号 

 单次: 频谱分析仪捕获满足触发条件的第

一个信号 

 连续: 频谱分析仪捕获满足触发条件的第

一个信号，然后返回到自由运行模

式 

操作 1. 按 > 触发模式[F3]选择触发模式: 

 Nor.: 
Sgl.: 
Cont.: 

正常 
单次 
持续 

 2. 按马上行动[F5]手动开始触发 
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设置触发延迟时间 
 

描述 设置频谱分析仪从触发到开始捕获信号时的延迟

时间。 

 延迟时间范围: 1ns~1ks 

操作 1. 按 >触发延迟[F4]设置触发延迟时间 

 延迟范围: 0~1000s 
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标记 
标记显示波形点的频率和幅值。GSP-930 可以同时开启 6 个 Marker
或ΔMarker 以及标记列表中 6 组峰值标记。 

标记列表可以在同一屏幕下编辑和检视多个标记。 

Δ标记显示了参考标记之间的频率和幅值差。 

GSP-930 能够自动将标记移至不同位置，包括峰值信号、中心频率以

及开始/停止频率。峰值搜索功能提供更多信号峰值的标记操作。 
 

 开启标记 →见 81 页 

 手动移动标记 → 见 81 页 

 移动标记至预设位置 → 见 82 页 

 开启Δ标记 → 见 82 页 

 手动移动Δ标记 → 见 84 页 

 标记功能 → 见 85 页 

 移动轨迹上的标记 → 见 87 页 

 显示标记列表 → 见 88 页 

 峰值搜索 → 见 89 页 

 峰值设置 → 见 91 页 

 峰值列表 → 见 92 页 
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开启标记 

提供两种基本标记类型：标准(Normal)标记和Δ标记。标准标记用

于测量轨迹上某点的频率/时间或幅值。Δ标记用于测量轨迹上参考

点和所选点之间的差值。 

开启常规标记 
 

操作 1. 按 > 选择标记[F1]选择标记编号 

 标记: 1~6 

 2. 按[F2]开启标记 

3. 按常规[F3]将标记设为标准(Normal)类型 

4. 标记置于轨迹上(默认中心)，屏幕上方显示标记

测量值 

Marker

Maker ID, Frequency, Amplitude

 

手动移动标记 
 

操作 1. 按 > 选择标记[F1]选择标记编号 
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 2. 使用左/右方向键移动标记(1 格/步
进) 

 

 3. 使用旋钮细调标记位置 

 

 4. 或者直接使用数字键输入标记频率 

 

移动标记至预设位置 
 

描述 键将标记移至不同预设位置。 

功能 标记>中心频率: 标
记>起始频率: 标记>
截止频率: 标记>中
心步进: 标记>参考

电平: 

移至中心频率 
移至起始频率 
移至停止频率 
移至中心步进频率 
移至参考电平幅值 

 注意 
使用 键可能会自动改变扫宽和其它设置 

操作 1. 按 > 选择标记[F1]选择标记编号 

2. 按 选择标记位置: 

 标记>中心频率[F1] 
标记>起始频率 [F2] 
标记>截止频率[F3] 
标记>中心步进[F4] 
标记>参考电平[F5] 

 

开启Δ标记 
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描述 Δ标记作为标记对，用于测量参考标记和Δ标记

之间频率/时间和幅值的差异。 

开启Δ标记时，参考标记和Δ标记出现在所选标

记位置；若未开启所选标记，则出现在屏幕中心

位置。 

标记测量位于屏幕顶部，Δ标记显示在“常规标

记”测量之下。 

Δ标记 Ref: 参考标记, 称为  

Delta: Δ标记, 称为  

操作 1. 按 > 选择标记[F1]选择标记编号 

2. 按[F2]开启标记 

3. 按差值[F4]>差值[F1]将标记设为Δ类型 
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手动移动Δ标记 
 

移动Δ或参考标

记 
1. 按 > 差值[F4]> 移动参考值[F2]移动参考标

记 

2. 按 > 差值[F4]> 移动差值[F3]移动Δ标记 

3. 所选标记的移动方式与标准(Normal)标记相同，

见 81 页 

移动参考和Δ标

记 
1. 按移动对跨度[F4]或移动对中心[F5]同时移动两

个标记 

 移动对跨度: 设置两个标记之间的扫

宽。扫宽分为正或负: 

+span  
 

 -span  

 移动对中心: 同时移动两个标记，并保

持两个标记间的频率跨度

不变。 

 2. 所选标记的移动方式与标准(Normal)标记相同，

见 81 页 
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标记功能 

标记噪声 
 

描述 噪声标记功能以标记位置为基准，计算 1Hz 带

宽内的平均噪声电平。 

操作 1. 按 > 选择标记[F1]选择标记编号 

2. 按[F2]开启标记 

3. 按常规[F3]，将标记移至期望的位置 

4. 按功能[F5]>噪声标记开启标记噪声 

5. 屏幕顶部以 dBm/Hz 为单位显示测量的噪声电

平 

Marker ID, Frequency, dBm/Hz

Marker
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计频器 
 

描述 计频功能用于精确计算频率。 

操作 1. 按 > 选择标记[F1]选择标记编号 

2. 按[F2]开启标记 

3. 按常规[F3]，将标记移到期望的位置 

4. 按功能[F5]>频率计数[F1] >频率计数[F1]开启计

频功能 

5. 按频率分辨率[F2]设置分辨率: 

 自动: 自动选择最好的分辨率 

 
手动: 手动设置分辨率 

 
手动范围: 1Hz, 10Hz, 100Hz, 1kHz 

 
6. 屏幕上方显示测量频率值 
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移动轨迹上的标记 
 

描述 标记轨迹功能将所选标记移至任意一个当前有效

的轨迹。 

操作 1. 按 > 选择标记[F1]选择标记编号 

2. 按[F2]开启标记 

 3. 按更多 1/2[F7]>标记轨迹[F1]，选择当前光标需

要移至的轨迹。仅可以选择有效轨迹 

 自动[F1] 
轨迹 1[F2] 
轨迹 2[F3]  
轨迹 3[F4]  
轨迹 4[F5] 

 
 

 
4. 如下例，Marker 1 移至 Trace1，Marker 2 移至

Trace2 

Marker 1, Trace 1

Marker 2, Trace 2  
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显示标记列表 
 

描述 GSP-930 具有标记列表功能，可以同时显示所有

有效标记和测量值。 

操作 1. 按 > 更多 1/2[F7]>标记列表[F2]开启标记列

表 

2. 屏幕分成上下两部分。下部显示标记列表，包括

标记 ID(正常, 参考或Δ)、轨迹、x 轴位置(频率/
时间)以及标记幅值 
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峰值搜索 

移动标记至峰值位置 
 

描述 键用于搜索轨迹峰值。 

操作 1. 按 > 选择标记[F1]选择标记编号 

2. 按 >峰值搜索[F1]，标记移至最高信号峰值

处 

3. 按 >更多 1/2[F7]>连续峰值[F1]并开启连续
峰值，每次扫描将会持续搜索峰值 

移动标记和峰值至中心频率 
 

描述 “标记->中心频率”功能将标记移至最高信号峰

值处，并将此信号峰值移至中心频率。 

操作 1. 按 > 选择标记[F1]选择标记编号 

2. 按 >标记->中心频率[F2] 

 注意 
不改变扫宽 
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峰值搜索 
 

描述 键用于搜索峰值。 

峰值搜索 下一个峰值: 搜索屏幕次高峰值 

 右侧峰值: 搜索标记右侧的下一峰值 

 左侧峰值: 搜索标记左侧的下一峰值 

 最小值搜索: 搜索最小峰值 

操作 1. 按 > 选择标记[F1]选择标记编号 

2. 按 选择希望搜索的峰值类型 

例如:  
下一个峰值 
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例如:  
右侧峰值 

 

例如:  
左侧峰值 

 

峰值设置 
 

描述 提供两种峰值搜索设置选项: 峰值漂移(Peak 
Excursion)和峰值门限(Peak Threshold)。 

 峰值漂移: 此设置为峰值阈值的最小值 

 峰值门限: 此设置为频谱分析仪检测峰值

的最小阈值准位。任何大于峰

值阈值+峰值偏移的值才能被

峰值检测到。 
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操作 1. 按 >更多 1/2[F7] 

2. 按峰值漂移[F2]设置偏移电平 

3. 按峰值门限[F3]设置峰值阈值 

 峰值漂移: 0~100dB 
峰值门限: -120dB~+30dB  

峰值列表 
 

描述 峰值列表功能将显示满足峰值设置条件的所有峰

值(最多 10 个)，列表内容包括峰值的幅值和频

率。 

操作 1. 按 >更多 1/2[F7]>峰值列表[F5] 

 2. 按峰值排序[F2]，设置排序类型:  

 频率: 
 
幅度: 

升序排列(频率) 
升序排列(幅值) 

 3. 按峰值列表[F1]打开峰值列表 
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 4. 屏幕分割为上下两部分。下部屏幕显示峰值列

表，包括峰值标记 ID、X 轴位置和幅值 
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显示 
Display 键用于基本设置，显示模式(频谱图, 光谱图, 拓扑图)以及分

割视窗模式设置。 

调整 LCD亮度 
 

描述 预设 3 种 LCD 亮度调节档位。 

操作 1. 按 > LCD 明亮度[F2]调节屏幕亮度:  

 高: 
中: 
低: 

高亮 
一般 
低亮 

关闭 LCD背光 
 

描述 不使用时，关闭 LCD 背光可以节省用电或延长

LCD 屏幕的使用寿命。 

操作 1. 按 > LCD 背光[F3]关闭 LCD 背光 

2. 再按任一功能键开启 LCD 背光 
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设置显示线(参考电平线) 
 

描述 显示线功能用于指示超过显示线的轨迹。 

操作 1. 按 > 显示线[F4]开启显示线 

2. 设置显示线电平和单位 

例如: 
 

Display line

 -50dBm显示线 

使用视频输出端子 
 

描述 GSP-930 配有一个专用的 DVI 终端，可以将屏幕

图像输出到外部监控器。视频输出总是开启状

态。 

 输出分辨率 800 x 600 (固定) 

操作 1. 将外部监控器接入后面板 DVI 端子 
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设置显示模式 
 

描述 GSP-930 提供三种显示模式: 频谱图, 光谱图和拓

扑图。通过分割视窗功能可以同时观察频谱图和

光谱图或拓扑图。 

 频谱图 默认显示模式 

 光谱图 在时域下观察频率或功率 

 拓扑图 观察轨迹的出现频率 

操作 1. 按 >视窗设置[F1]选择显示模式: 

 频谱图[F1]: 
光谱图[F3]: 
拓扑图[F4]: 
光谱图+频谱图[F5]: 
拓扑图+频谱图[F6]: 

 注意 
在光谱+频谱和拓扑+频谱模式下，上下视窗均为

同一轨迹。 
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例如: 
光谱图 

 

光谱图在频域和时域下显示信号。X 轴代表频

率，Y 轴代表时间，颜色代表该频率&该时间点

的幅值(红色 = 高 蓝 = 低)。 
 
新轨迹始终显示在光谱图最底部，旧轨迹逐渐上

移直至删除。 

拓扑图 

 

拓扑图体现轨迹发生频率。该模式有利于观察被

强信号覆盖掉的弱小信号或间歇信号。颜色表示

轨迹发生频率，红色较高，蓝色代表偶发事件。 



  GSP-930使用手册 

98 

光谱图 
+频谱图 

 

同时显示信号的光谱图和频谱图 

拓扑图 
+频谱图 

 

同时显示信号的拓扑图和频谱图 

分割频谱视窗 
 

描述 使用分割视窗功能，用户可以同时观察两种不同

扫描范围的频谱图。上下视窗具有独立的扫描范

围、幅值、扫宽和其它设置。但是每次仅扫描一

个视窗(上或下)。 
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操作 1. 按 >视窗设置[F1]>分割频谱[F2]>活动窗口
[F1]激活上方视窗 

2. 按活动窗口[F1]切换上/下视窗的轨迹扫描 

3. 按交替扫描[F2]交替扫描上/下视窗 

 注意 
在交替扫描模式下无需进行操作。 

退出该功能后，频谱分析仪继续启用激活的视窗

设置。另一视窗设置将在下次开启分割视窗功能

时使用。 

举例: 
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系统设置 

系统信息 
 

描述 系统信息显示如下: 

 
 
序列号 

 
安装选件 

版本:  校准日期: 
软件 LO1 
固件 RF 
文件系统 TG 
RF DNS 主机名 
TG MAC 地址 
DSP LXI密码 
词汇表  
核  

操作 1. 按 >系统资讯[F1]生成系统信息列表 

错误信息 
 

描述 错误信息列表包括信息编码、描述和时间，用于

记录操作仪器时出现的所有错误。详情见编程手

册。 

操作 1. 按 >错误消息[F2]生成错误信息列表 

2. 按上一页[F2]和下一页[F3]翻页 

3. 按清除错误队列[F6]清除列表中的错误信息 

设置系统语言 
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描述 GSP-930 支持多国语言。使用软菜单键选择系统

语言。 

操作 1. 按 >Language[F3]选择系统语言 

设置日期和时间 
 

操作 1. 按 >时间日期[F4] 

 2. 按设置日期[F1]设置日期: 

 年[F1] 设置年 
 月[F2] 设置月 
 日[F3] 设置日 

 3. 按设置时间[F2]设置系统时间: 

 小时[F1] 设置时(24hr) 
 分钟[F2] 设置分 
 秒[F3] 设置秒 

 4. 系统时间和日期显示在屏幕顶部 
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使用唤醒时钟 
 

描述 GSP-930 的唤醒时钟功能可以在预设时间自动开

启频谱分析仪。 

操作 1. 按 >时间日期[F4]>唤醒时钟编辑[F3]，设置

如下参数: 

 选择时钟[F1] 
 
选择唤醒时钟(1~7) 

 状态[F2] 开启/关闭所选时钟 
 小时[F3] 设置唤醒：时 
 分钟 [F4] 设置唤醒：分 
 连续. 单次[F5] 设置重复或单次唤醒 

 注意 
唤醒时钟是针对所选的单独一天进行配置的。 
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报警输出 
 

描述 允许 ALARM OUT 端子输出通过/失败信号。 

 输出: 集电极开路 

Vo

R
Alarm Out

BNC

+V

 

操作 1. 按 >警报输出[F6]打开/关闭报警输出

(ALARM OUT)端子 
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预设 
预设功能可以调取默认出厂状态或用户自定义状态。 

 

 使用预设键 →见 104 页 

 保存用户预设值→ 见 104 页 

 设置预设类型→ 见 105 页 

 开机初始化设置 → 见 105 页 

使用预设键 
 

描述 键调取默认出厂状态或自定义预设状态。

预设类型见 105 页。 

出厂设置 默认出厂设置见 196 页。 

操作 按 键调取预设内容 

保存用户预设值 
 

描述 将当前状态保存为自定义预设内容。 

操作 按 >电源开/复位[F5]>保存用户设定[F3] 将
当前状态保存为用户自定义预设内容 
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设置预设类型 
 

描述 每按一次 键，调取一次预设。预设内容可

选择出厂默认设置或用户自定义设置。 

操作 1. 按 >电源开/复位[F5]>复位类型[F2]选择预

设类型:  

 用户复位[F1]  
出厂复位[F2] 

开机初始化设置 
 

描述 仪器开机后，调取默认预设内容或上次关机前设

置。 

操作 1. 按 >电源开/复位[F5]>电源开[F1]选择开机

设置:  

 开机设置: 上次, 复位 

 注意 
详情见 209页设置预设类型。 

若仪器未正确关机，则不能调取关机前设置。详

情见 25页。 
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高级操作 
 

测量 ........................................................................................................ 107
通道分析概述 ....................................................................................................... 107

ACPR ......................................................................................................... 109
OCBW ....................................................................................................... 112

AM/FM 解调与分析 ........................................................................................... 114
AM 分析 .................................................................................................... 114
FM分析 .................................................................................................... 117
AM/FM 解调 ........................................................................................... 120

N dB 带宽 .............................................................................................................. 121
相位抖动测量 ....................................................................................................... 122
频谱辐射屏蔽概述 .............................................................................................. 124
频谱辐射屏蔽测试 .............................................................................................. 136
三阶互调失真(TOI) ............................................................................................ 141
CNR/CSO/CTB 测量 ......................................................................................... 143

载波噪音比(CNR) .................................................................................. 143
复合二次差异(CSO) .............................................................................. 146
复合三次差异(CTB) .............................................................................. 147

限制线测试 .......................................................................................... 150
编辑限制线(逐点) ................................................................................................ 150
编辑限制线(从轨迹数据) .................................................................................. 151
编辑限制线(从标记数据) .................................................................................. 152

删除限制线 .............................................................................................. 153
通过失败测试 ......................................................................................... 154

序列 ........................................................................................................ 156 
编辑序列 .................................................................................................. 156
执行序列 .................................................................................................. 159
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测量 
本章节介绍如何使用自动测量模式。GSP-930 包含如下测量: 

 

 ACPR  → 见 109 页 

 OCBW → 见 112 页 

 AM 解调 → 见 114 页 

 FM 解调 → 见 117 页 

 N dB 测量 → 见 121 页 

 相位抖动 → 见 122 页 

 SEM 测量 → 见 124 页 

 TOI 测量 → 见 141 页 

 CNR/CSO/CTB 测量 → 见 143 页 

通道分析概述 
 

描述 通道分析测量包括 ACPR (邻近通道功率比)和
OCBW (占用带宽)测量。 

参数 通道带宽 目标通道占据的频宽。 
范围:  
0Hz~3GHz 
(0Hz 除外) 

通道间隔 各主通道之间的频率间

距。 
范围:  
0Hz~3GHz 

邻近通道带宽 1 & 2 邻近通道占据的频宽。 
范围:  
0Hz~3GHz 
(0Hz 除外) 
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邻近通道偏移 1 ~ 3 邻近通道和主通道之间的

频率间距。 
范围: 1 
0Hz~3GHz 
(0Hz 除外) 

OCBW% 占用带宽所耗功率与总功

率之比。 
范围: 0%~100%, 0.1%分

辨率 
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ACPR 
 

描述 邻近通道功率比是指主通道泄漏到邻近通道的功

率量。其值为主通道功率与邻近通道功率之比。 

例如 

Main 
CHBW

ADJ
CH1

ADJ
CH2

ADJ
CH3

ADJ
CH1

ADJ
CH2

ADJ
CH3

Offset 1
Offset 2
Offset 3

Channel spacing
To next main 

channel  

操作: 
设置主通道 

1. 按 > 频道分析[F1]>ACPR [F2]开启 ACPR 
 其它任何测量模式将自动关闭 

2. 屏幕分为上下两部分。上部屏幕显示主通道、邻

近通道和它们的相应限制。下部屏幕实时显示

ACPR 测量结果 
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ADJCH2

Channel power 
results

ADJCH3

ADJCH1
Main CH

 

 3. 按 > 频道分析[F1]>ACPR 设置[F1]>，选

择: 

 主频道带宽[F1] 设置主通道带宽 
 主频道高界限[F2] 设置主通道上限 
 主频道低界限[F3] 设置主通道下限 
 频道空间[F4] 指定通道间隔 

操作: 
设置邻近通道(s) 

1. 按 ADJ 空间设置[F5]设置邻近通道: 

选择 ADJ 频道[F1] 选择邻近通道: 1, 2, 3 
 [F2] 打开/关闭此通道 
 ADJ频道带宽 [F3] 选择此通道带宽 
 ADJ频道偏移 [F4] 设置邻近通道偏移 
 ADJCH HLimit[F5] 设置邻近通道上限 
 ADJCH LLimit[F6] 设置邻近通道下限 

 2. 若需要，重复上述步骤设置其它邻近通道 
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上/下移动通道 1. 按 > 频道分析[F1]，参照如下按键移至另

一通道: 

频道上移[F5] 上一个主通道 
频道下移[F6] 下一个主通道 

 注意 
频道空间(CH SPC)参数决定下一主通道的位

置。 
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OCBW 
 

描述 占用带宽测量被用于测量占用通道的功率与这个

信道的功率百分比。  

例如 

CH BW

OCBW

 

操作: 
设置主通道 

1. 按 > 频道分析[F1]>OCBW[F4]开启 OCBW 
 其它任何测量模式将自动关闭 

2. 屏幕分为上下两部分。上部屏幕显示通道带宽。

下部屏幕实时显示 OCBW 测量结果 
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 3. 按 OCBW 设置[F3]进入 OCBW 设置: 

频道带宽[F1] 设置通道带宽 
 频道空间[F2] 设置各主通道之间的通道

间隔 
 OCBW%[F3] 设置 OCBW 与 CHBW 的

百分比 

上/下移动通道 1. 按 > 频道分析[F1]，选择: 

频道上移[F5] 上一个主通道 
频道下移[F6] 

下一个主通道 

 注意 
通道间隔(CH SPC)参数决定下一主通道的位置。 

ACPR和 OCBW设置中的 CH SPC参数是独立的。 
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AM/FM解调与分析 

AM分析 
 

描述 开启调幅解调功能后，输入信号集中在中心频

率，扫宽自动设为零。 

测量项 AM 调制深度: 当前, 最小, 最大 

调制. 率: 当前, 最小, 最大 

 载波功率: 当前, 最小, 最大 

 载波频率偏移: 当前, 最小, 最大 

 SINAD: 当前, 最小, 最大 

操作: 
设置 

1. 将中心频率设为载波频率(见 36 页) 

2. 按 > 解调[F2]>调幅分析[F1]>调幅分析[F1]
开启 AM 分析 

 其它任何测量模式将自动关闭 

3. 屏幕分为上下两部分。上部屏幕显示时域 AM 波

形。下部屏幕显示 AM 测量 
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 4. 按设置[F2]>中频带宽[F1]设置中频带宽 
 确保带宽足以调解载波所含频谱 

 5. 按低通滤波器[F2]设置低通滤波器频率，另外该

滤波器也可设置成绕开: 
 

 

 AM 信号频率(Hz) 
  LPF 可选带宽(Hz) 

  ≥78,125 156,250 78,125 52,083 39,063 31,250 
  ≥39,063 78,125 39,063 26,042 19,531 15,625 
  ≥19,531 39,063 19,531 13,021 9,766 7,813 
  ≥7,813 15,625 7,813 5,208 3,906 3,125 
  ≥3,906 7,813 3,906 2,604 1,953 1,563 
  ≥1,953 3,906 1,953 1,302 977 781 
  ≥781 1,563 781 521 391 313 
  ≥391 781 391 260 195 156 
  ≥195 391 195 130 98 78 
  ≥78 156 78 52 39 31 
  ≥39 78 39 26 20 16 
  ≥20 39 20 13 10 8 
  ≥8 16 8 5 4 3 

 6. 按时间轴 [F3]设置水平轴参数: 

 参考值[F1] 设置起始时间 
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 参考位置[F2] 转换的波形在细分网格上

的位置（X）号 
 刻度/格 [F3] 自动缩放关闭时设置每格

刻度 
 自动缩放[F4] 开启/关闭自动缩放 

 7. 按深度轴[F4]设置深度(垂直)参数: 

 参考值[F1] 参考位置偏移，以垂直刻

度/格的百分比表示 
 参考位置[F2] 设置波形在水平细分网格

上的参考位置。 (1:10) 
 刻度/格[F3] 自动缩放关闭时设置水平

格刻度 
 自动缩放[F4] 开启/关闭自动缩放 

操作: 
触发设置 

8. 按 AF 触发[F5]设置触发条件: 

自由运行[F1] 关闭触发，此为默认设置  
 边沿斜率[F2] 设置上升沿或下降沿触发 
 触发模式[F3] 设置触发模式: 

不: 正常触发 
单次: 单次触发 
连续: 连续触发 

 触发电平[F4] 设置触发电平，与深度成

百分比关系 
 触发延迟 [F5] 设置触发延迟时间:  

0~1ks 
 立即运行[F6] 关闭自由运行(FreeRun)

模式，使用自定义触发设

置 

 注意 
保持 MAX和 MIN测量值，直至出现更大或更小值。

按 >解调[F2]>调幅分析[F1]>最小/最大复位[F3]
重设 MAX和 MIN测量值。 
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FM分析 
 

描述 开启调频解调功能后，输入信号集中在载波频

率，扫宽自动设为零。 

测量项 频率偏移: 当前, 最小, 最大 

调制率: 当前, 最小, 最大 

 载波功率: 当前, 最小, 最大 

 载波频率偏移: 当前, 最小, 最大 

 SINAD: 当前, 最小, 最大 

操作: 
设置 

1. 将中心频率设为载波频率(见 36 页) 

2. 按 > 解调[F2]>调频分析[F2]>调频分析[F1]
开启调频分析 

 其它任何测量模式将自动关闭 

3. 屏幕分为上下两部分。上部屏幕显示时域调频波

形。下部屏幕显示调频测量 
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 4. 按设置[F2]>中频带宽[F1]设置中频带宽(10kHz, 
30kHz, 100kHz, 300kHz, 1MHz, ) 

 确保带宽足以解调载波所含频谱 

 5. 按低通滤波器[F2]设置低通滤波器频率，另外该

滤波器也可设置成绕开: 
 

 

 FM 信号频率(Hz) 
  LPF 可选带宽(Hz) 

  ≥78,125 156,250 78,125 52,083 39,063 31,250 
  ≥39,063 78,125 39,063 26,042 19,531 15,625 
  ≥19,531 39,063 19,531 13,021 9,766 7,813 
  ≥7,813 15,625 7,813 5,208 3,906 3,125 
  ≥3,906 7,813 3,906 2,604 1,953 1,563 
  ≥1,953 3,906 1,953 1,302 977 781 
  ≥781 1,563 781 521 391 313 
  ≥391 781 391 260 195 156 
  ≥195 391 195 130 98 78 
  ≥78 156 78 52 39 31 
  ≥39 78 39 26 20 16 
  ≥20 39 20 13 10 8 
  ≥8 16 8 5 4 3 

 

 6. 按时间轴[F3]设置水平轴参数: 
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 参考值[F1] 设置起始时间 
 参考位置[F2] 转换的波形在细分网格上

的位置（X）号。 
 刻度/格[F3] 自动缩放关闭时设置每格

刻度 
 自动缩放[F4] 打开/关闭自动缩放 

 7. 按偏差轴[F4]设置深度(垂直)参数: 

 参考值[F1] 参考位置偏移 (在频率 
上). 

 参考位置[F2] 设置波形在水平细分网格

上的参考位置。 (1:10) 
 刻度/格[F3] 设置水平格刻度 
 自动缩放[F4] 打开/关闭自动缩放 

操作: 
触发设置 

8. 按 AF 触发[F5]设置触发条件: 

自由运行[F1] 关闭触发，此为默认设置 
边沿斜率[F2] 设置上升沿或下降沿触发 

 触发模式[F3] 设置触发模式: 
不: 正常触发 
单次: 单次触发 
连续: 连续触发 

 触发电平[F4] 作为频率设定的触发电

平。 
 触发延迟[F5] 设置触发延迟时间:  

0~1ks 
 立即运行[F6] 关闭自由运行(FreeRun)

模式，使用自定义触发设

置 

 注意 
保持 MAX和 MIN测量值，直至出现更大或更小值。

按 >解调[F2]>调频分析[F1]>最小/最大复位[F3]
重设 MAX和 MIN测量值 
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AM/FM解调 
 

描述 GSP-930 提供的 AM/FM 解调功能，可以将 AM
或 FM 的调制信号恢复为基带信号，并通过耳机

输出插孔收听。 

操作: 
设置 

1. 将中心频率设为期望的 FM/AM 载波频率。详

情见 36 页 

2. 将扫宽设为零。详情见 40 页 

3. 将前置放大(Preamp)设为自动。见 53 页 

接口 将耳机或扬声器插入耳机输出端口 

 

操作 4. 按 > 解调[F2]>声音[F3]>耳机输出[F1]打开

耳机输出 

 5. 按音量[F2]设置音量输出: 

 音量: 0~15, 默认 7 

 6. 按数位增益控制[F3]改变增益: 

 增益: 0~18dB, 6dB 步进 

 7. 按解调类型[F4]选择 AM 或 FM 解调 
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N dB带宽 
 

描述 N dB 用于测量从峰值至指定幅值(N dB)所覆盖

的频率带宽。 

例如 

N dB 
BW

N dB

 

操作 1. 按 > NdB 带宽[F3]>NdB 带宽[F1]开启 N 
dB 带宽 

 其它任何测量模式将自动关闭 

2. 屏幕分为上下两部分。上部屏幕显示波形轨迹和

标记。下部屏幕实时显示 N dB 测量结果 

 

3. 按 NdB[F2]设置 NdB 幅值:  
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 幅值: 0.1dB ~ 80.0 dB 

 注意 
NdB带宽测量与 RBW和 VBW密切相关。 

相位抖动测量 
 

描述 相位抖动指的是相位波动的次数，用于评估信号

在时域的稳定度。 

参数 起始偏移:  起始频率相对于中心频率 

停止偏移:  停止频率相对于中心频率 

测量项 载波功率:  dBm 

相位抖动:  rad 

抖动时间:  ns 

例如 

Stop Offset
Start Offset

 

操作: 
设置主通道 

1. 按 > 相位抖动[F4]>相位抖动[F1]开启相位

抖动 
 其它任何测量模式将自动关闭 

2. 屏幕分为上下两部分。上部屏幕显示波形轨迹和

起始、停止频率偏移。下部屏幕显示相位抖动测

量 
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 3. 按起始偏移 [F2]设置起始频率偏移: 

 偏移: (0Hz ~ ½扫宽) 

 4. 按停止偏移[F3]设置停止频率偏移:  

 偏移: (0Hz ~ ½扫宽) 

 注意 
相位抖动测量与 RBW和 VBW密切相关。 
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频谱辐射屏蔽概述 
 

描述 频谱辐射屏蔽测量的是通道外相对于通道内的功

率泄漏量。频谱辐射屏蔽测量通常计算指定的不

同偏移载波频率带上的功率。频谱辐射屏蔽往往

使用不同无线标准测量。 

针对 3GPP，GSP-930 支持 FDD（频分双工）和

TDD（时分双工）模式的 BS（基站）和 UE（用

户设备）测试标准。 

 GSP-930 也支持 802.11b, 802.11g, 802.11n 和

802.16 的 SEM 测试以及用户自定义的辐射屏蔽

测试。 

例如 

 

参数  通道整合带宽:  
 

通道整合带宽。通道整合带宽

是测试通道内功率。 

通道扫宽:  
 

测试通道功率时，用于定义主

通道的扫宽。 

分辨率带宽:  
 

测试通道内功率时，设置主通

道的分辨率带宽。  
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总功率参考:  
 

计算偏移功率时，载波总功率

被用来作为参考。 

功率谱密度参考: 载波功率谱密度用于参考计算

偏移功率。 

选择偏移:  选择偏移对(1 ~ 5)用于配置。 

起始频率:  
 

设置所选偏移数的起始频率偏

移。 

截止频率:  
 

设置所选偏移数的截止频率偏

移。 

分辨率带宽:  
 

设置所选择偏移数的分辨率带

宽。 

Abs 起始:  
 

设置所选择偏移数与起始频率

上午绝对限制电平。 

Abs 截止:  
 

设置选择偏移数与截止频率的

绝对限制电平。绝对截止可以

被设成一对或手动。手动允许

用户自定义绝对截止，一对将

锁定绝对截止到绝对起始限制

电平。 

Rel 起始:  
 

设置选择偏移数相对起始频率

的限制电平。 

Rel 截止:  
 

设置选择偏移数相对截止频率

的限制电平。参考截止可以被

设成一对或手动。手动允许用

户自定义参考截止，一对将锁

定参考截止到参考起始限制电

平。 
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失败模板: 
 

关于测量失败条件的限制电平

设置: 绝对, 相对, 绝对& 相对, 
绝对或 相对。 

测量项 
主通道带宽: 

 
单位: Hz 

总功率:  单位: dBm 

PSD (功率谱密度):  
 
单位: dBm/Hz 

偏移 1~5:  下 dBm, 上 dBm 

3GPP Operating Bands* 

 
Operating 
Band 

UL Frequencies 
UE transmit, Node B receive  

DL Frequencies 
UE receive, Node B transmit 

I 1920~1980MHz 2110~2170MHz 

II 1850~1910MHz 1930~1990 MHz 

II 1710~1785MHz 1805~1880MHz 

IV 1710~1755MHz 2110~2155MHz 

V 824~849MHz 869~894MHz 

VI 830~840MHz 875~885MHz 

VII 2500~2570MHz 2620~2690MHz 

VIII 880~915MHz 925~960MHz 

IX 1749.9~1784.9MHz 1844.9~1879.9MHz 

X 1710~1770MHz 2110~2170MHz 

XI 1427.9~1452.9MHz 1475.9~1500.9MHz 

XII 698~716MHz 728~746MHz 

XIII 777~787MHz 746~756MHz 

XIV 788~796MHz 758~768MHz 

XV Reserved Reserved 
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XVI Reserved Reserved 

XVII Reserved Reserved 

XVIII Reserved Reserved 

XIX 830~845MHz 875~890MHz 

XX 832~862MHz 791~821MHz 

XXI 1447.9~1462.9MHz 1495.9~1510.9MHz 

XXV 1850~1915MHz 1930~1995MHz 

*for FDD, 参考 ETSI:  

3GPP TS 25.101 version 10.2.0 Release 10 
3GPP TS 25.104 version 10.2.0 Release 10 
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3GPP-FDD BS For the FDD configuration, different limits can by chosen based on the 
total channel power, P. 

The default value for Δfmax is 12.5MHz. Δfmax can be user-defined. 

The channel span is set to 5MHz. 

Note: A, B, C, D, E denote offsets 1 to 5, respectively. 

 P≥43 
Unit: MHz Abs[1] RBW 

2.5 ≤A<2.7 -14dBm 30kHz 

2.7≤B<3.5 -14 ~ -26dBm 30kHz 

3.5≤C<Δfmax -13dBm 1MHz 

 39≤P<43 
Unit: MHz Abs[1] RBW 

2.5 ≤A<2.7 -15dBm 30kHz 

2.7≤B<3.5 -14 ~ -26dBm 30kHz 

3.5≤C<7.5 -13dBm 1MHz 

7.5≤D<Δfmax P-56dB 1MHz 

 31≤P<39 
Unit: MHz Abs[1] RBW 

2.5 ≤A<2.7 P-53dB 30kHz 

2.7≤B<3.5 P-53dB~ 
P-56dB 

30kHz 

3.5≤C<7.5 P-52dB 1MHz 

7.5≤D<Δfmax P-56dB 1MHz 

 P<31 
Unit: MHz Abs[1] RBW 

2.5 ≤A<2.7 -22dBm 30kHz 

2.7≤B<3.5 -22 ~ -34dBm 30kHz 

3.5≤C<7.5 -21dBM 1MHz 

7.5≤D<Δfmax -25dBm 1MHz 
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 For P<31, two additional power limits (shown below) can be selected via 
the Additional Max Out. Pwr option for Home BS applications: 

(The default value for Δfmax is 14.5 MHz.  Δfmax can be user-defined) 

 6≤P≤20 
Unit: MHz Abs[1] RBW 

12.5 ≤E< Δfmax P- 56dB 1MHz 

 P<6 
Unit: MHz Abs[1] RBW 

12.5 ≤E< Δfmax -50dBm 1MHz 

3GPP-FDD BS Additional 
Requirements 

For operation in bands II, IV, V, X, XII, XIII, XIV and XXV, additional 
requirements (listed below) apply in addition to the minimum 
requirements listed above.  

 Bands:  
II, IV, X 

Unit: MHz Additional[3] RBW 

2.5 ≤A<3.5 -15dBm 30kHz 

3.5≤B< Δfmax -13dBm 1MHz 

 Bands: V 
Unit: MHz Additional[3] RBW 

2.5 ≤A<3.5 -15dBm 30kHz 

3.5≤B< Δfmax -13dBm 100kHz 

 Bands:  
XII, XIII, XIV 

Unit: MHz Additional[3] RBW 

2.5 ≤A<3.5 -13dBm 30kHz 

3.5≤B< Δfmax -13dBm 100kHz 

3GPP-FDD UE The channel span is set to 5MHz. 

Note: A, B, C, D, E denote offsets 1 to 5, respectively. 

 Unit: MHz 
Rel Abs[1] RBW 

2.5 ≤A<3.5 -35~-50dBc -71.1dBm 30kHz 

3.5 ≤B<7.5 -35~-39dBc -55.8dBm 1MHz 

7.5 ≤C<8.5 -39~-49dBc -55.8dBm 1MHz 

8.5 ≤D<12.5 -49~-49dBc -55.8dBm 1MHz 

3GPP-FDD UE Additional Additional requirements for 3GPP-FDD UE. 
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Requirements 
Bands  
II, IV, X 

Unit: MHz Additional[3] RBW 

2.5 ≤A<3.5  -15dBm 30kHz 

3.5≤B<12.5 -15dBm 1MHz 

 Band V 
Unit: MHz Additional[3] RBW 

2.5 ≤A<3.5  -15dBm 30kHz 

3.5≤B<12.5 -13dBm 100kHz 

 Bands  
XII, XIII, XIV 

Unit: MHz Additional[3] RBW 

2.5 ≤A<3.5  -13dBm 30kHz 

3.5≤B<12.5 -13dBm 100kHz 

3GPP-TDD BS 
3.84Mcps* 

For the TDD configuration, different limits can by chosen based on the 
total channel power,  

The channel span: 
3.84Mcps: 5MHz. 

Note: A, B, C, D, E denote offsets 1 to 5, respectively. 

 P≥43 
Unit: MHz Abs[1] RBW 

2.5 ≤A<2.7 -14dBm 30kHz 

2.7≤B<3.5 -14 ~ -26dBm 30kHz 

3.5≤C<12 -13dBm 1MHz 

 39≤P<43 
Unit: MHz Abs[1] RBW 

2.5 ≤A<2.7 -14dBm 30kHz 

2.7≤B<3.5 -14 ~ -26dBm 30kHz 

3.5≤C<7.5 -13dBm 1MHz 

7.5≤D<12 P-56dB 1MHz 
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 31≤P<39 
Unit: MHz Abs[1] RBW 

2.5 ≤A<2.7 P-53dBm 30kHz 

2.7≤B<3.5 P-53~P-65dBm 30kHz 

3.5≤C<7.5 P-52dBm 1MHz 

7.5≤C<12 P-56dBm 1MHz 

 P≤31 
Unit: MHz Abs[1] RBW 

2.5 ≤A<2.7 -22dBm 30kHz 

2.7≤B<3.5 -22 ~ -34dBm 30kHz 

3.5≤C<7.5 -21dBm 1MHz 

7.5≤D<12 -25dBm 1MHz 
*referenced from ETSI: 
3GPP TS 25.102 version 10.2.0 Release 10 
3GPP TS 25.105 version 10.3.0 Release 10 

3GPP-TDD BS 
1.28Mcps 

The channel span: 
1.28Mcps: 1.6MHz. 

 P≥34 
Unit: MHz Abs[1] RBW 

0.8 ≤A<1 -20dBm 30kHz 

1≤B<1.8 -20 ~ -28dBm 30kHz 

1.8≤C<3.5 -13dBm 1MHz 

 26≤P<34 
Unit: MHz Abs[1] RBW 

0.8 ≤A<1 P-54dB 30kHz 

1≤B<1.8 P-54~P-62dB 30kHz 

1.8≤C<3.5 P-47dB 1MHz 

 P<26 
Unit: MHz Abs[1] RBW 

0.8 ≤A<1 -28dBm 30kHz 

1≤B<1.8 -28~-36dBm 30kHz 

1.8≤C<3.5 -21dBm 1MHz 
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3GPP-TDD BS 
7.68 Mcps 

The channel span: 
7.68Mcps: 10MHz. 

 P≥43 
Unit: MHz Abs[1] RBW 

5 ≤A<5.2 -17dBm 30kHz 

5.2≤B<6 -17 ~ -29dBm 30kHz 

6≤C<24.5 -16dBm 1MHz 

 39≤P<43 
Unit: MHz Abs[1] RBW 

5≤A<5.2 -17dBm 30kHz 

5.2≤B<6 -17 ~ -29dBm 30kHz 

6≤C<15 -16dBm 1MHz 

15≤D≤24.5 P-59dB 1MHz 

 31≤P<39 
Unit: MHz Abs[1] RBW 

5≤A<5.2 P-56dB 30kHz 

5.2≤B<6 P-56~P-68dB 30kHz 

6≤C<15 P-55dB 1MHz 

15≤D≤24.5 P-59dB 1MHz 

 P<31 
Unit: MHz Abs[1] RBW 

5≤A<5.2 -25dBm 30kHz 

5.2≤B<6 -25~-37dBm 30kHz 

6≤C<15 -24dBm 1MHz 

15≤D≤24.5 -28dBm 1MHz 
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3GPP-TDD UE The channel span: 
3.84Mcps: 5MHz. 
1.28Mcps: 1.6MHz. 
7.68Mcps: 10MHz. 

Note: A, B, C, D, E denote offsets 1 to 5, respectively. 

 3.84Mcps 
Unit: MHz Rel[2] RBW 

2.5 ≤A<3.5 -35~-50dBc 30kHz 

3.5≤B<7.5 -35 ~ -39dBc 1MHz 

7.5≤C<8.5 -39~-49dBc 1MHz 

8.5≤D<12.5 -49dBc 1MHz 

 1.28Mcps 
Unit: MHz Rel[2] RBW 

0.8 ≤A<1.8 -35~-49dBc 30kHz 

1.8≤B<2.4 -49~-59.2dBc 30kHz 

2.4≤C<4 -44dBc 1MHz 

 7.68Mcps 
Unit: MHz Rel[2] RBW 

5 ≤A<5.75 -38~-46dBc 30kHz 

5.75≤B<7 -46 ~ -53dBc 30kHz 

7≤C<15 -38~-42dBc 1MHz 

15≤D<17 -42~-52dBc 1MHz 

17≤E<25 -53dBc 1MHz 

802.11b* The channel span: 22MHz 

Note: A, B denotes offsets 1 and offset 2. 
Here the default value of “f” is 24MHz. This can be user-defined. 

  
Unit: MHz Rel[2] RBW 

11≤A<22 -30dBc 100kHz 

22≤B<f -50dBc 100kHz 
*reference: IEEE Std 802.11b-1999 
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802.11g The channel span:  
ERP-OFDM/DSSS-OFDM : 18MHz  
ERP-DSSS/ERP-PBCC/ERP-CCK: 22MHz 

Note: A, B, C, D denote offsets 1 to 4, respectively. 
Here the default value of “f” is 40MHz (ERP-OFDM/ DSSS-OFDM) or 
25MHz (ERP-DSSS/ ERP-PBCC/ ERP-CCK). This can be user-defined. 

 ERP-OFDM/ 
DSSS-OFDM 

Unit: MHz Rel[2] RBW 

9 ≤A<11 -0~-20dBc 100kHz 

11≤B<20 -20~-28dBc 100kHz 

20≤C<30 -28~-40dBc 100kHz 

30≤D<f -40dBc 100kHz 

 ERP-DSSS/ ERP-
PBCC/ ERP-CCK 

Unit: MHz Rel[2] RBW 

11 ≤A<22 -30dBc 100kHz 

22≤B<f -50dBc 100kHz 
*reference: IEEE Std 802.11a-1999 

802.11n The channel span:  
CH BW 20MHz: 18MHz  
CH BW 40MHz: 38MHz 

Note: A, B, C, D denote offsets 1 to 4, respectively. 
Here the default value of “f” is 40MHz(CHBW 20MHz) or 70MHz(CHBW 
40MHz). This can be user-defined. 

 CH BW 20MHz 
Unit: MHz Rel[2] RBW 

9 ≤A<11 -0~-20dBc 100kHz 

11≤B<20 -20~-28dBc 100kHz 

20≤C<30 -28~-45dBc 100kHz 

30≤D<f -45dBc 100kHz 

 



 GSP-930使用手册 

135 

 CH BW 40MHz 
Unit: MHz Rel[2] RBW 

19 ≤A<21 0~-20dBc 100kHz 

21≤B<40 -20~-28dBc 100kHz 

40≤C<60 -28~-45dBc 100kHz 

60≤D<f -45dBc 100kHz 
*reference: IEEE Std 802.1n-2009 

802.16* The channel span:  
CH BW 20MHz: 19MHz  
CH BW 10MHz: 9.5MHz 

Note: A, B, C, D denote offsets 1 to 4, respectively. 
Here the default value of “f” is 16.75MHz(CHBW 20MHz) or 
31.5MHz(CHBW 10MHz). This can be user-defined. 

 CH BW 20MHz 
Unit: MHz Rel[2] RBW 

9.5 ≤A<10.9 0~-25dBc 100kHz 

10.9≤B<19.5 -25~-32dBc 100kHz 

19.5≤C<29.5 -32~-50dBc 100kHz 

29.5≤D<f -50dBc 100kHz 

 CH BW 10MHz 
Unit: MHz Rel[2] RBW 

4.75 ≤A<5.45 0~-25dBc 100kHz 

5.45≤B<9.75 -25~-32dBc 100kHz 

9.75≤C<14.75 -32~-50dBc 100kHz 

14.75≤D<f -50dBc 100kHz 
*reference: IEEE Std 802.16-2009 

 注意 
[1] Abs: Absolute limit 
[2] Rel: Relative limit(to the total power or the power spectral 
density, depending on the compliance of the main channel) 
[3] Additional: Additional absolute limit 
Pass Fail Criteria:  

Case 1: When both Abs and Rel are used, the highest value 
(Abs or Rel) is used as the Pass/Fail judgment.  The trace 
points under the limit indicate a pass. 
Case2: If the additional limit is used, the higher value from 
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case1 is compared to the additional limit. The lowest one is 
used as the pass/fail judgment. 

频谱辐射屏蔽测试 
 

描述 对于频谱辐射屏蔽测试，GSP-930 可预先定义

3GPP 测试参数 802.11x 和 802.16，也可以执行

用户自定义的 SEM 测试。 

操作:  1. 按 > 频谱辐射屏蔽[F5]>频谱辐射屏蔽[F2]
开启频谱辐射屏蔽 

 其它任何测量模式将自动关闭 

 2. 屏幕分为上下两部分。上部屏幕显示信号轨迹和

绝对/相对屏蔽限制。下部屏幕显示频谱辐射屏

蔽测量结果 

 

自定义参数 1. 按设置[F1]>用户定义[F6]设置自定义频谱辐射屏

蔽测量参数 
 

 2. 按测量类型[F1]选择参考总功率[F1]或 PSD 参考
[F2] 
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 3. 按参考频道[F2]，设置如下内容:  

 频道覆盖带宽[F1] 设置通道覆盖带宽 
 频道扫宽[F2] 设置通道扫宽 
 分辨率带宽[F3] 设置分辨率带宽 
 参考总功率[F4]/ 

PSD参考[F4] 
设置总功率/PSD 参考电

平 

 4. 按返回[F7]返回上级菜单 
 

 5. 按偏移/限制[F3]设置偏移参数:  

 选择偏移 F1] 选择偏移 
 打开/关闭[F2] 开启/关闭所选偏移 
 起始频率[F3] 设置所选偏移的起始频率 
 截止频率[F4] 设置所选偏移的截止频率 
 分辨率带宽[F5] 设置所选偏移的分辨率带

宽 

 6. 按更多 1/2[F6]设置绝对、相对电平限制和条件: 
 

绝对起始[F2] 设置所选偏移的绝对起始

电平限制 
绝对截止[F3] 设置所选偏移的绝对截止

电平限制 
 
手动: 允许用户自定义绝

对截止电平 
一对: 设置绝对截止电平

至绝对起始电平。 
相对起始[F4]  
 

设置所选偏移的相对起始

电平限制 
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 相对截止[F5]  
 

设置所选偏移的相对截止

电平限制 

手动: 允许用户自定义相

对截止电平。 

一对: 设置相对截止电平

至相对起始电平。 

 7. 按失败屏蔽[F6]设置不合格屏蔽条件: 
 

绝对[F1] 设置绝对电平限制为不合

格条件 
相对[F2] 设置相对电平限制为不合

格条件 
 绝对与相对[F3] 设置绝对和相对电平限制

为不合格条件 
 绝对或相对[F4] 设置绝对或相对电平限制

为不合格条件 

 8. 按选择偏移[F1]，重复以上步骤设置其它偏移 

 偏移: 1~5 

预设测试参数: 
3GPP 

3GPP 频谱辐射屏蔽测试参数见 124 页频谱辐射

屏蔽概述。 

1. 按设置[F1]>3GPP[F1]选择 3GPP 测量 

 2. 按参考频道[F2]，设置如下内容:  
 

分辨率带宽[F3] 设置分辨率带宽 

 3. 预先定义所有其它通道设置 

 4. 按返回[F7]返回上级菜单 

 5. 按偏移/界限[F3]>双工模式[F1]选择 FDD 或
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TDD 双工:  

 6. 按 FDD 设置[F2]设置 FDD 参数；对于 TDD，

按 TDD 设置[F3]: 

 传送[F1] 切换 BS 和 UE 测试 
 芯片速率[F2] 选择 RRC 滤波器带宽用

于测量 TDD 信道功率。

双工：  
3.84MHz, 1.28MHz, 
7.68MHz 

 最大输出功率[F2/F3] 设置 BS 测试的最大输出

功率: 
P>=43 
39<=P<=43 
31<=P<=39 
P<31 

 附加频段[F4] 选择 FDD 分工的操作带

宽: 
无 
频段 II 
频段 IV 
频段 V 
频段 X 
频段 X11 
频段 XIII 
频段 XIV 

 最小偏移/ 
界限[F4] 

检视每个偏移参数，包括

起始/截止频率、分辨率

带宽、绝对起始/截止和

相对起始/截止 

预设测试参数: 
802.XX 

802.11x 和 802.16 频谱辐射屏蔽测试参数见 124
页频谱辐射屏蔽概述。 

1. 按设置[F1]>选择 802.XX 测试: 
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 802.11b[F2]  
 802.11g[F3]  
 802.11n[F4]  
 802.16[F5]  

 2. 按参考频道[F2]检视预定义设置，包括频道覆盖

带宽、频道扫宽、分辨率带宽和选择偏移 

 3. 按偏移/界限[F3]检视每个偏移参数值，包括起始

和截止频率、分辨率带宽、相对起始和截止 
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三阶互调失真(TOI) 
 

描述 三阶互调失真测量是计算由非线性系统中频率相

近的两个信号产生的 TOI 信号。上下三阶交调点

(IP3)的计算。标记放在产生 TOI 的频率点以及

基频信号频率点。 

限制线可以被放在上下 TOI 产生点做通过/失败

测试。 

参数  参考下部 设置参考电平至低基频信号。 

参考上部 设置参考电平至高基频信号。 

 限制 设置通过/失败测试限制，单

位 dBm 

 通过/失败 打开/关闭通过/失败测试 

测量项 上部基频 频率, dBm, dBc. 

下部基频 频率, dBm, dBc 

 3rd Order 下部 频率, dBm, dBc, 限制, 截获点 

 3rd Order 上部 频率, dBm, dBc, 限制, 截获点 

 Δf 频率 
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例如 

3rd Order Upper
Base Lower

3rd Order Lower

Limit

Base Upper

Δf

 

操作:  1. 按 > TOI[F6]>TOI[F1]打开 TOI 
 其它任何测量模式将自动关闭 

 2. 屏幕分为上下两部分。上部屏幕显示信号轨迹、

上下基频标记以及上下三阶互调信号标记。下部

屏幕显示 TOI 测量和 Pass/Fail 结果 

TOI measurement and results

3rd Order 
lower 

marker

Lower and 
upper base

3rd Order 
upper 
marker

 
 

 3. 按参考[F2]设置上/下基频参考值 
 

 4. 按限制[F3]设置上下三阶互调信号的幅值限制 
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 5. 按通过/失败[F4]打开/关闭通过/失败测试 

CNR/CSO/CTB测量 

载波噪音比(CNR) 
 

描述 载波噪音比计算传输过程中载波信号与噪声电平

的幅值差。CNR 测量用于模拟和数字 CATV。 

参数 噪声标记 两种方式设置 Δ标记(Δ1)位
置:  
 
MIN:  
在载波频率和载波频率

+4MHz 范围内搜索最小幅值 
 
ΔMarker: 
自定义 Δ标记位置 

测量项 图像载波 频率, 幅值 

CNR 幅值差 

 Δf 图像载波与噪声标记的频率差 

例如 

C
N

R
 dB

1

Δ1

Δf

Visual carrier marker

Noise 
marker

Aural, audio 
carrier

Channel 
spacing

To next main channel  

操作:  1. 按 > CNR/CSO/CTB[F7]>Setup[F1]> 
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CNR[F1]选择 CNR 测量 

2. 按 Noise Marking[F1]切换噪声标记类型：Min 或
ΔMarker 

3. 若选择 Min，再按 Return[F7]返回上级菜单 

4. 若选择 ΔMarker，再按 > 
Delta[F4]>Delta[F1]设置 Δ标记位置 

 移动标记见 81 页 

按 > CNR/CSO/CTB[F7]返回上级菜单 

 5. 按 CNR[F2]开启 CNR 
 其它任何测量模式将自动关闭 
 确保 CNR 开启前关闭声音和色度子载波 

 6. 屏幕分为上下两部分。上部屏幕显示信号轨迹、

图像载波标记和噪声标记。下部屏幕显示 CNR
测量 

 
 

 7. 按 CNR CH SP[F2]设置通道间隔 
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 范围: 0~3GHz  

 8. 按 Channel Move Down[F4]或 Channel Move Up 
[F5]移至下/上一个通道 

 

 注意 
CNR测量前，确保关闭声音和色度子载波。 
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复合二次差异(CSO) 
 

描述 复合二次测量用于计算载波信号与复合二次差拍

物之间的幅值差。 

参数 CSO CH SP: 通道间隔 

测量项 图像载波: 频率, 幅值 
通道间隔: 频率 
CSO: 幅值差 

例如 

C
S

O
 

dB

 

操作:  1. 按 > CNR/CSO/CTB[F7]>Setup[F1]> 
CSO[F2]选择 CSO 

2. 按 CSO[F2]开启 CSO 
 其它任何测量模式将自动关闭 

 3. 屏幕分为上下两部分。上部屏幕显示信号轨迹、

图像载波标记和 CSO 差拍标记。下部屏幕显示

CSO 测量 
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 4. 按 CSO CH SP[F2]设置通道间隔 
 

 范围: 0~3GHz  

 5. 按 Channel Move Down[F4]或 Channel Move Up 
[F5]移至下/上一个通道 

 

复合三次差异(CTB) 
 

描述 复合三次差异测量用于计算图像载波与复合三次

差拍之间的幅值差。 

测量项 图像载波: 频率, 幅值 
CTB: 图像载波与三次差拍的幅值差 
三次差拍: 幅值 
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例如 

C
T

B
 

dB

 

操作:  1. 按 > CNR/CSO/CTB[F7]>Setup[F1]> 
CTB[F2]>Return[F7]选择 CTB 测量并返回上级菜

单 

2. 按 CTB[F2]开启 CTB 
 其它任何测量模式将自动关闭 

 3. 屏幕分为上下两部分。上部屏幕显示信号轨迹和

图像载波标记。下部屏幕显示 CTB 测量 
 标记( )记录图像载波幅值 

 
 

 4. 关闭图像载波信号输入，并按前面板 键 
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5. 显示第二轨迹，标记 CTB 幅值 
 ( )标记在第二轨迹，计算( - ) 

 6. 按 CTB CH SP[F2]设置通道间隔 

 范围: 0~3GHz  

 7. 按 Channel Move Down[F4]或 Channel Move Up 
[F5]移至下/上一个通道 

 

 注意 
按 Setup[F1]>CTB[F3]> Restart[F1]再次执行 CTB测量 
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限制线测试 
在全频段范围内设置上/下幅值限制，用于检测输入信号是否超出、

低于或在限制线范围内。 

限制线可以自动或手动编辑。 

  

 编辑限制线(逐点) → 见 150 页 

 编辑限制线(从轨迹数据) → 见 151 页 

 编辑限制线(从标记数据) → 见 152 页 

  注意 此功能将改变限制线外 Marker 1的位置 

 删除限制线 → 见 153 页 

 通过失败测试 → 见 154 页 

编辑限制线(逐点) 
 

描述 手动逐点创建限制线。最多可设置 10 个频率

点。 

操作 1. 按 > 编辑界限[F1]>选择界限[F1]选择限制

线 

 限制线: 1~5 

 2. 按逐点详述[F2] 

屏幕分为上下两部分。上部屏幕显示信号轨迹和

限制线。下部屏幕显示限制线列表 
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3. 按点[F1]选择编辑点(必须从#1 开始) 

4. 按频率[F2]设置第一个点的频率 

5. 按限制[F3]设置点的幅值 

所有设置内容显示在屏幕下方的限制线列表里 

6. 重复 3-5 步设置其余频率点(最多 10) 

7. 按删除点[F6]删除所选点 

8. 按返回[F7]>保存界限[F5]保存当前所选限制线 

 注意 
限制线上的点自动依频率大小排序(低 → 高) 

编辑限制线(从轨迹数据) 
 

描述 根据轨迹数据和起始、停止频率创建限制线(10
个频率点)。 

操作 1. 按 > 编辑界限[F1]>选择界限[F1]选择限制
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线 

 限制线: 1~5 

 2. 按轨迹数据界限[F3] 

屏幕分为上下两部分。上部屏幕显示信号轨迹和

限制线。下部屏幕显示限制线列表 

 

3. 按限制电平[F2]设置偏移电平 

4. 按创建界限立即[F1] 
 根据信号轨迹和偏移电平，自动创建限制线 
 不限编辑次数 

5. 按返回[F7]>保存界限[F5]保存当前限制线 

编辑限制线(从标记数据) 
 

描述 根据标记数据创建限制线，详情见 79 页。最多

可设置 10 个频率点。 

操作 1. 按 > 编辑界限[F1]>选择界限[F1]选择限制
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线 

 限制线: 1~5 

 2. 按标记数据至界限[F4] 

屏幕分为上下两部分。上部屏幕显示信号轨迹和

限制线。下部屏幕显示限制线列表 

 

3. 按点[F1]选择编辑点(必须从#1 开始) 

4. 按限制电平[F3]设置偏移电平 

5. 按标记数据至点[F2] 

6. 使用旋钮移动标记位置。按 Enter 键确认 

7. 重复 3-5 步设置其余频率点(最多 10) 

8. 按返回[F7]>保存界限[F5]保存当前限制线 

 注意 
此功能将改变限制线外 Marker 1的位置 

删除限制线 
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描述 可以删除任意一条限制线。 

操作 1. 按 > 编辑界限[F1]>选择界限[F1]选择需要

删除的限制线(限制线 1~5) 

2. 按删除界限[F6]删除限制线数据 

通过失败测试 
 

描述 通过/失败测试前，必须首先保存上下限制线，

见 111 页。 

操作 1. 按 >通过/失败 测试 

2. 按高界限[F1]选择一条限制线作为上限 

3. 按低界限[F2]选择一条限制线作为下限 

4. 按通过标准[F3]选择通过条件 

 条件:  全部, 最大, 最小 

 5. 按通过/失败 打开测试 

6. 测试结果显示在屏幕下方 

 Pass:   

 Fail:  

显示图标 
 

测试开启时，AlM图标显示在屏幕下方 
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 注意 
测试需至少开启一条限制线(高或低)。 

如果关闭上限或下限，最大或最小*显示电平自

动设为上或下限。 
 
* +30dBm+参考电平偏移或-120dBm+参考电平偏移 
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序列 
序列功能记录和执行用户定义的步骤，在重复或单次运行模式下最多

提供 5 组序列，每组 20 个操作步骤。每组序列可以插入延迟和暂停

指令，方便在操作过程中观察测量结果。序列之间也可以相互调取。 
 
相关内容如下: 

 

 编辑序列  → 见 156 页 

 执行序列 → 见 159 页 

编辑序列 
 

编辑序列 1. 按 > 选择序列[F1]选择需要编辑/创建的序

列 

 序列: 1~5 

 2. 按编辑[F2]>开始编辑[F1]开始编辑序列 

 3. 屏幕分为上下两部分。上部屏幕为主显示。下部

屏幕显示序列编辑内容及步骤 
 图标显示在序列编辑视窗 
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增加步骤 每一序列提供 20 个步骤。每次面板操作都可以

记作一个步骤。 
面板操作完成后，按 键记录步骤(有时不必

执行 – 观察操作是否在序列编辑视窗)。 
 
例如，在序列中增加中心频率和扫宽: 

1. 按 >中心频率[F1]>20MHz>  

2. 按 >零扫宽[F3]>  

3. 步骤加入指令集 

 

 注意 
使用方向键将标记移到插入点 

增加延迟功能 序列插入延迟时间。 

1. 按延时[F2]>输入延迟时间 

 范围: 100ms ~ 10s 
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 2. 按 插入 
 指令集增加延迟步骤 

  

 注意 
使用方向键将标记移到插入点 

暂停序列 暂停执行序列，方便在进入下一步骤前观察测量

结果。按继续[F1]继续。 

1. 按是否继续序列[F3]>  
 是否继续序列作为一个插入步骤 

  

2. 按继续[F1]结束暂停功能，继续执行指令集 

插入序列 在当前指令集中插入另一指令集。 

1. 按选择执行序列[F4]> 选择插入的序列 
 序列作为一个插入步骤 

 

 注意 
当前序列不能自我插入 

删除步骤 可以删除任意一个编辑步骤。 

 1. 使用方向键将标记移到删除点 
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 2. 按删除步骤[F5] > 删除步骤 
 该步骤将从序列中移除 

 

停止编辑 1. 按停止编辑[F6] 

2. 图标关闭 

保存当前序列 序列编辑(停止)完成后可以保存。 

1. 按 >保存序列[F4] > 保存序列 

删除当前序列 1. 按 >删除序列 [F5] > 删除当前序列 

执行序列 
 

执行模式 1. 按 > 选择序列[F1]选择一个序列 

2. 按运行模式[F6]切换运行模式: 

 单次 仅运行一次序列 
 连续 持续运行序列直至按停止

运行序列[F7](注: 停止运

行序列[F7]选项仅出现在

进行中的序列) 
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执行序列 3. 按立即运行[F7]运行序列 

4. 按停止运行序列[F7]停止运行 
 在单次模式，当所有步骤都完成后，序列自动停

止运行 
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跟踪源 
选配的跟踪源可以产生一个扫描信号，其扫描时间和频率范围都与

GSP-930 匹配。利用其幅值在整个频率范围内维持在一个恒定值，有

助于测试待测体的频率响应。 

 

 开启跟踪源  → 见 161 页 

 跟踪源归一化→ 见 162 页 

开启跟踪源 
 

操作 1. 按 >更多 1/2[F7]>选择[F1]>跟踪发生器
[F1]> 跟踪发生器[F1]打开跟踪源 

 开启 TG 输出 
 

2. 按跟踪发生器电平[F2]设置跟踪源的输出电平 

 范围: -50~0dBm 
 

3. 按参考信号电平[F3]设置跟踪源的偏移电平，补

偿系统增益/损耗 

 范围: -10dB~10dB 
 

4. 按 TG 电平步进[F4]设置 TG 电平的步进分辨率 

 范围: 0.5~50dB, 0.5dB 步进 

 5. 按功率扫描[F5] TG 随扫描速率输出功率。扫描

开始时，输出功率为设置的 TG 电平，扫描完一

次后，TG 电平线性增加/减少使功率等于设置的

功率扫描电平 

 范围: -5dB~+5dB 
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跟踪源归一化 
 

背景 归一化的量为每次扫描后的轨迹减去参考轨迹。

使得最终轨迹被归一化到参考电平。 

操作 1. 按 >更多 1/2[F7]>选择[F1]>跟踪发生器
[F1]>跟踪发生器[F1]打开跟踪源 

 2. 按归一化[F6]进入归一化菜单 
 

3. 按标准参考等级[F2]设置归一化垂直参考电平 

 范围: 0dB~100dB 
 

4. 按标准参考位置[F3]设置归一化轨迹偏移 

 范围: 10~0 格 
(由上至下) 

 
5. 按归一化 [F4]开启/关闭归一化数据 

或按存储参考[F1]再次执行归一化 

 注意 
如果 X-轴的相关参数或 TG输出电平改变，归一化

数据将自动关闭。 

此时提示警告信息“Execute Normalization again!” 
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功率计 
选择功率计时，GSP 能测量和记录 1MHz~6.2GHz 全操作频率范围

内 -32dBm ~ +20dBm 待测物的平均功率。 
 
 

 开启功率计模式 → 见 163 页 

 记录功率计测量值 → 见 165 页 

开启功率计模式 
 

操作 1. 按 > 功率计[F2]进入功率计模式 

 2. 屏幕分为上下两部分。上部屏幕显示功率测量

(dBm 或 W)。下部屏幕显示测量值曲线图 

Data log of power measurements

Power meter measurement

Power meter bar

 
 

3. 按 Power Unit[F1]选择单位: 

 单位 dBm, W 
 

4. 按频率[F2]选择测量频率: 
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 频率 1MHz~6200MHz 
 分辨率: 1MHz 
 

5. 按传感器模式[F3]选择功率计的测量速度(和精确

度): 

 低噪声: 100ms/sample,  典型 
 快速: 30ms/sample, 典型 
 

6. 按通过/失败测试[F4]设置通过失败测试参数: 

 上限[F1]: -100dBm~20dBm 
 下限[F2]: -100dBm~20dBm 
 通过/失败测试[F3]: 开, 关 
 通过图标:   
 失败图标:  
 

7. 按触发[F5]选择自由运行(内部)触发或外部触发 

 触发: 自由运行, 外部 

 外部触发输入:  3.3V CMOS  
 

 
 

8. 按最大/最小 保持[F6]开启/关闭最大/最小 保持

功能 
 最小/最大测量值显示在屏幕中央的条状功率表 

 

 

 注意 
按 > 频谱[F1]返回频谱模式 
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记录功率计测量值 
 

描述 在功率计模式下，频谱分析仪根据用户预设时间

周期和间隔记录功率计测量值。 

操作 1. 按 进入存储菜单 

 2. 按类型[F2]选择功率计[F7] 

 3. 按数据源[F3]选择功率状态[F1] 

 4. 按功率计 记录选项[F4]设置如下选项: 

 记录停止[F1]: 设置数据记录时间: 
00 :00 :00 (持续记录)或 
00 :00 :01 ~ 23 : 59: 59 

 记录步[F2]: 1s ~ 999s 

 5. 按保存至[F1]选择存储位置: 

 寄存器 1~6: 内部寄存器，不属于内部存储

器 
 本地: 内部存储器 
 SD 卡: 外部 Micro SD 卡 

 注意 
只有插入 Micro SD卡时，才显示 Micro SD Card。 

 6. 选定存储位置后，显示记录选项 

 7. 按名称[F1]命名文件。使用 F1~F7
键或数字键盘输入数字 

 
 

限制: 
 无空格 
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 仅可以使用字符 1~9, A~Z, a~z 

  

8. 文件名显示在屏幕下方 
 

  

按 确认  

 注意 
如果没有定义文件名，系统将自动按照如下格式

创建: 

文件名: 类型_数据源_文件编号.文件扩展名 

每次新建同类型文件，文件编号增加。 

 9. 按现在记录[F3]开始记录功率计测量值 

记录完成后，屏幕下方显示“SaveFinish‼”。 

停止记录 按记录停止[F2]停止记录 
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文档 

文档概述 
文档功能用于处理文档导航、排序、复制和删除。GSP-930 提供多种

文档格式，包括轨迹数据、限制线、幅值校准、指令集和其它面板操

作。文档来源和目标位置(内部存储器, USB 或 Micro SD)也可以由文

档功能选择。 

 

 文档类型概述 → 见 168 页 

 文档类型 → 见 169 页 

 文档浏览 → 见 170 页 

 复制文档 → 见 172 页 

 移动文档 → 见 172 页 

 删除文档 → 见 173 页 

 重命名文档→ 见 174 页 

 保存文档 → 见 176 页 

 调取文档 → 见 178 页 

 快速保存 → 见 180 页 
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文档类型概述 
 

内部存储器 GSP-930 提供 16MB 的内部存储器。 

USB GSP-930 支持外部 U 盘。 

 USB类型: 1.1/2.0 

Micro SD GSP-930 支持 Micro SD 卡。 

 格式:  SDSC, SDHC  
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文档类型 
 

概述 按顺序列出各类文档类型。 

状态 包含每一步面板操作的状态: 
 频率 
 扫宽 
 幅值 
 BW/Avg 
 扫描 
 轨迹 
 显示 
 测量 
 限制线 

 指令集 
 触发 
 标记 
 Marker-> 
 峰值搜索 
 预设 
 模式 
 系统 

轨迹 轨迹数据以逗号间隔： 
 中心频率 
 扫宽 
 分辨率带宽 
 视频带宽 
 参考电平 
 扫描时间 
 点数(轨迹数据点) 

屏幕截图 JPEG 文件(800X600) 

限制线 限制线数据以逗号间隔: 
 点数 
 点的频率值 
 点的量级 
 量级单位 
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校准 包含如下校准(线)数据: 
 点数 
 点的频率值 
 点的增益偏移 
 单位 

指令集 指令集文档包括指令集编号和该指令集的步进操

作。此数据用户不可编辑 

功率计 功率计数据包含: 
 日期 
 时间 
 功率 dBm 

文档浏览 
 

连接外部存储器 将 U 盘或 Micro SD 卡插入前面板适当位置。 

选择文档 1. 按 >文件管理器 

2. 选择存储位置:  

 Local[F1]: 内部存储器 
 USB[F2]: 前面板 U 盘 
 SD Card[F3]: Micro SD 卡 

 3. 使用上/下方向键或旋钮向上或向下

移动文档列表 

 

 4. 使用左/右方向键向后或向前翻页 
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按类型浏览 可以仅浏览某一类型的文档。有关文档类型的详

细介绍见 168 页。 

1. 按类型[F2]选择一种文档类型: 

 All 浏览所有类型 
 State 仅浏览状态文档 
 Trace 仅浏览轨迹文档 
 Screen  仅浏览屏幕截图 
 Limit Line 仅浏览限制线 
 Correction 仅浏览校准数据 
 Sequence 仅浏览序列文档 
 Power Meter 仅浏览功率计文档 

 选择一种文档类型后，文档浏览功能仅列出这些

文档类型。 

文档排序 以文件名或日期升序排序。默认按名称排序。 

1. 按排序方式[F3]选择排序类型: 

 名称: 以字母顺序排序 
 日期: 以编成日期排序 

 注意 
只有插入 U盘/SD卡时，U盘和 Micro SD卡选项才可

用。 
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复制文档 
 

描述 可以将内部存储器中的文档复制到外部 U 盘或

Micro SD 卡，反之亦然。 

连接外部存储器 将 U 盘或 Micro SD 卡插入前面板适当位置。 

选择文档 1. 按 >文件管理器 

2. 从内部或外部存储器中选择一个文档 

3. 按复制[F4] 

4. 按多媒体 [F1]选择复制到目标位置(内部存储器, 
U 盘, SD 卡) 

5. 按复制 [F2] 

6. 完成文档复制 

 注意 
只有插入 U盘/SD卡时，U盘和 Micro SD卡选项才可

用。 

移动文档 
 

描述 可以将内部存储器中的文档移到外部 U 盘或

Micro SD 卡，反之亦然。 

连接外部存储器 将 U 盘或 Micro SD 卡插入前面板适当位置。 
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选择文档 1. 按 >文件管理器 

2. 从内部或外部存储器中选择一个文档 

3. 按移至[F7] 

4. 按多媒体 [F1]选择移到目标位置(内部存储器, U
盘, SD 卡) 

5. 按立即移动 [F2] 

6. 完成文档移动 

 注意 
只有插入 U盘/SD卡时，U盘和 Micro SD卡选项才可

用。 

删除文档 
 

描述 内部存储器或外部 U 盘或 Micro SD 卡中的任何

文档都可以删除。 

连接外部存储器 将 U 盘或 Micro SD 卡插入前面板适当位置。 

删除文档 1. 按 >文件管理器 

2. 从内部或外部存储器中选择一个文档 

3. 按删除[F5] 

4. 按删除[F1] 

5. 完成文档删除 

删除警告 1. 按删除警告[F2]选择是否提示确认对话框: 

 不请求 删除文档时不提示确认对话框 
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 请求 提示用户确认是否删除文档 

 注意 
只有插入 U盘/SD卡时，U盘和 Micro SD卡选项才可

用。 

重命名文档 
 

描述 内部存储器或外部 U 盘或 Micro SD 卡中的任何

文档都可以重新命名。 

连接外部存储器 将 U 盘或 Micro SD 卡插入前面板适当位置。 

重命名文档 1. 按 >文件管理器 

2. 从内部或外部存储器中选择一个文档 

3. 按重新命名[F6] 

 4. 使用 F1~F7 键或数字键盘输入数字: 

 
 

 限制: 
 无空格 
 仅可以使用字符 1~9, A~Z, a~z 
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 5. 新文件名显示在文档列表 

 

6. 按 确认 

 注意 
只有插入 U盘/SD卡时，U盘和 Micro SD卡选项才可

用。 
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保存文档 
 

描述 使用 键可以保存任意一个功能设置。 

连接外部存储器 将 U 盘或 Micro SD 卡插入前面板适当位置。 

保存文档 1. 按 进入存储菜单 

 2. 按类型[F2]选择保存的文档类型。文档类型介绍

见 168 页: 

 状态: 状态数据 
 轨迹: 轨迹数据 
 屏幕: 屏幕截图 
 界限: 限制线数据 
 幅度校正: 校准数据 
 序列: 序列文档 
 功率计 功率计数据 

 3. 如果有需要，按数据源[F3]选择数据源: 

 对于状态数据: 内部状态数据 
 对于轨迹数据: 轨迹 1~4 
 对于屏幕截图: 正常: 直接保存屏幕截图 

省墨: 反转图像文档颜色，减少

打印用墨量 
 对于限制线: 限制线 1~5 
 对于校准: 校准数据 1~5 
 对于序列: 序列 1~5 
 对于功率计: 功率计 1 ~5 

 4. 对于轨迹数据，按格式[F4]选择保存的格式类型:  

 轨迹: 仅保存轨迹数据 
 轨迹+状态: 保存轨迹数据和状态数据 
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 5. 按保存至[F1]选择目标位置: 

 寄存器 1~6: 内部寄存器，不属于内部存储

器 
 本地: 内部存储器 
 USB: 外部存储器 
 SD Card: 外部 Micro SD 卡 

 6. 选择目标位置后，文档可以立即命名或保存 

 7. 按名称[F1]命名文件。使用 F1~F7
键输入字母或数字键盘输入数字: 

 
 

限制: 
 无空格 
 仅可以使用字符 1~9, A~Z, a~z 

  

8. 文件名显示在屏幕下方 
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9. 按 确认 

 注意 
若未定义文件名，系统将使用默认命名。 

 10. 按立即保存[F3]保存所选的文档类型 

保存成功后，屏幕下方显示“SaveFinish‼”。 

 注意 
如果没有定义文件名，系统将自动按照如下格式

创建: 

文件名: 类型_数据源_XX.文件扩展名 

图像文件自动按如下格式创建: 

文件名: NowPicture_XX.jpg 

每创建一个同类型文档，XX参数增加。 

 注意 
只有插入 U盘/SD卡时，U盘和 Micro SD卡选项才可

用。 

调取文档 
 

描述 使用 键调取文档。 

连接外部存储器 将 U 盘或 Micro SD 卡插入前面板适当位置。 

 1. 按 进入调取菜单 

2. 按类型[F2]选择保存的一个文档类型。文档类型



 GSP-930使用手册 

179 

介绍见 168 页: 

 状态: 状态数据 
 轨迹: 轨迹数据 
 界限: 限制线数据 
 幅度校正: 校准数据 
 序列: 指令集文档 
 功率计 功率计数据 

 3. 按数据源[F3]将文档类型调取至目标位置: 

 对于状态数据: 内部状态数据 
 对于轨迹数据: 轨迹 1~4 
 对于限制线: 限制线 1~5 
 对于校准: 校准数据 1~5 
 对于指令集: 指令集 1~5 
 对于功率计: 功率计 1 ~5 

调取文档 1. 按召回[F1]选择调取位置: 

 寄存器 1~6: 内部寄存器，不属于内部存储

器 
 本地: 内部存储器 
 USB 外部 U 盘 
 SD Card: 外部 Micro SD 卡 

 2. 按立即召回[F1]调取文档类型 

3. 调取成功后，屏幕下方显示“Finish‼” 

 注意 
只有插入 U盘/SD卡时，U盘和 Micro SD卡选项才可

用。 
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快速保存 
 

描述 按 键即可保存文档。 

需要的文档类型由 键预先设置。 

默认情况下， 键将屏幕截图保存到内部存

储器或外部 U 盘(已插入)。 

支持的文档类型 屏幕截图, 轨迹, 状态, 限制线, 校准, 指令集 

连接外部存储器 将 U 盘或 Micro SD 卡插入前面板适当位置。 

快速保存设置 1. 按 键，确认文档类型、数据源和格式。详

情见 176 页 

使用快速保存键 1. 使用以上设置，任意时刻按 键保存所设文

档类型 

2. 保存完成后，屏幕下方显示“Save Finish‼” 

 注意 
数据文档将自动按照如下格式创建名称: 

文件名: 类型_数据源_XX.文件扩展名 

图像文件自动按如下格式创建: 

文件名: QuickJpg_XX.jpg 

每创建一个同类型文档，XX参数增加。 

 注意 
只有插入 U盘/SD卡时，U盘和 Micro SD卡选项才可

用。 
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远程控制 
GSP-930 支持以 IEEE488.2 标准为基础的远程控

制。指令列表请参考编程手册，登陆固纬网站下载

www.gwinstek.com。 
 

接口设置 ............................................................................................... 182
设置 USB 远程接口 ............................................................................................. 182
设置 GPIB 接口 ................................................................................................... 182
设置 LAN和 LXI 接口 ....................................................................................... 183
设置 RS232C .......................................................................................................... 186
RS232C 远程控制功能查询 ............................................................................... 186
LXI 浏览器界面和功能查询 ............................................................................ 188
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接口设置 

设置 USB远程接口 
 

USB设置 PC接口 Type A, host 

GSP接口 后面板 Type B, slave 

速度 1.1/2.0 (全速/高速) 

 USB Class USB TMC (USB T&M class) 

面板操作 1. 将 USB 线接入后面板 USB B 接口 

 

 2. 按 >更多 1/2[F7]>远程界面配置[F2] >USB
模式[F5]，将 USB 模式切换成装置 

 注意 
切换 USB模式可能会花费一些时间。 

设置 GPIB接口 

必须首先安装 GPIB 接口(选配)。 
 

设置 GPIB 1. 关闭频谱分析仪 

 2. 将 GPIB 线接入仪器的 GPIB 接

口  

 3. 开启频谱分析仪  

 4. 按 >更多 1/2[F7]>远程界面配置[F2]>GPIB 
地址，设置 GPIB 地址 

 GPIB地址 0~30 
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GPIB限制  最多连接 15 台装置；电缆总长不超过 20m，每台
装置之间电缆不超过 2m 

 每台装置分配独立的地址 
 至少开启 2/3 的 GPIB 设备 
 无回路或并行连接 

设置 LAN和 LXI接口 

GSP-930 与 class C LXI 兼容，仪器可以完成基本远程控制或 LAN
监控。 

LXI 规格和兼容类型见 LXI 网站 http://www.lxistandard.org。 
 

背景 通过 LAN 接口网络远程控制仪器。频谱分析仪

支持 DHCP 连接，能自动连入既有网络。此

外，也可以手动完成网络设置。  

LAN设置 IP地址 默认网关 

子网掩码 域名服务器 

DHCP 开启/关闭  

连接  将以太网线接入后面板 LAN 接

口。 
 

设置 1. 按 >更多 1/2[F7]>远程界面配置[F2]> 
LAN[F2]>局域网配置[F1]进行 LAN 设置:  

 IP地址[F1] 设置 IP 地址 
 子网掩码[F2] 设置子网掩码 
 默认网关[F3] 设置默认网关 
 DNS 服务[F4] 设置域名服务器地址 
 配置 LAN [F5] 切换 LAN 设置：DHCP 或手

动设置 

 2. 按应用[F6]确认 LAN 设置 
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显示图标  与 LAN接口相连，LXI图标变成绿色；如果

开启“验证”设置，图标变亮，见 188页。 

设置密码 LXI 网页密码可以通过频谱分析仪设置。密码显

示在系统信息中。 

默认密码: lxiWNpwd 

1. 按 >更多 1/2[F7]>远程界面配置

[F2]>LAN[F2]>LXI 密码[F2]设置密码 

 2. 使用 F1~F7 输入字母或数字键盘输

入数字组成密码: 

 

 限制: 
 无空格 
 仅可以使用字符 1~9, A~Z, a~z 

ABCDE

FGHIJ

KLMNO

PQRST

UVWXY

Z

A

C

D

E

B

Lowercase

Return

a

c

d

e

b

Return

LXI
Password>

Return

 
密码菜单树 

 3. 密码显示在屏幕下方 
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4. 按 确认设置 

重设 LAN 使用 LAN 接口前，可能需要重设 LAN 设置。 

1. 按 >更多 1/2[F7]>远程界面配置[F2]>局域
网设置[F3]重设 LAN 

2. GSP-930 自动重启 

 注意 
每次重设 LAN，密码将恢复成默认值。 

默认密码: lxiWNpwd 
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设置 RS232C 
 

背景 RS232C 接口用于远程控制 PC。 

RS232C设置 波特率 停止位: 1 (固定) 

奇偶性: 无(固定) 数据位: 8 (固定) 

连接  将 RS232C 线接入后面板 RS232
接口。 

 

 1. 按 >更多 1/2[F7]>远程界面配置[F2]>RS232 
传输速率[F4]设置波特率 

 
300 600 1200 
2400 4800 9600 
19200 38400 57600 
115200   

RS232C远程控制功能查询 
 

功能查询 调取一个终端应用，如 MTTTY (Multi-
Threaded TTY)。 

使用 PC 设备管理器查询 COM 端口号。对于

WinXP; 控制面板 → 系统 → 硬件列表。 

 在仪器设置成 RS232 远程控制后(见 184 页)，从

终端操作查询指令。 

*idn? 

返回制造商、型号、序列号和固件版本，格式如

下： 

 GW-INSTEK,GSP-930, XXXXXXXXXXXX, 
V.X.X.X.X 
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制造商: GW-INSTEK 
型号 : GSP-930 
序列号 : XXXXXXXXXXXX 
固件版本 : V.X.X.X 

 注意 
详情见编程手册，GW Instek网站下载 
www.gwinstek.com 



  GSP-930使用手册 

188 

LXI浏览器界面和功能查询 
 

功能查询 仪器设置完成并连到 LAN 接口后(见 183 页)，
在网络浏览器上输入频谱分析仪的 IP 地址。 

http:// XXX.XXX.XXX.XXX 

网络浏览器界面显示如下: 

登陆页面 登陆页面列出所有 LXI 和 LAN 设置以及仪器验

证设置。仪器验证功能可以关闭。 
 

 

 注意  验证设置开启时，LXI图标变亮。 
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查看&修改设置 可以从浏览器上修改 LAN 设置，但是必须先输

入密码。 

密码: lxiWNpwd 
[注意: 密码区分大小写] 
 

  

 注意 
如果选择“Factory Defaults”选项，密码恢复至默认

值。 

当信息提示需要操作网络浏览器时，必须手动重

设频谱分析仪。 
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SCPI指令 可以直接在浏览器上输入 SCPI 指令，完全实现

远程控制。详情见编程手册。使用远程指令前必

须输入密码。 
 
密码: lxiWNpwd 
[注意: 密码区分大小写] 
 

 

捕获图像 PC 浏览器远程捕获屏幕截图。 
 

 

 注意 
详情见编程手册，GW Instek网站下载 
www.gwinstek.com 
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GPIB/LAN控制功能查询 
 

功能查询 请使用美国国家仪器测量&自动控制软件确认

GPIB/LAN 功能。 
 
详情见美国国家仪器网站

http://www.ni.com。 

 注意 
详情见编程手册，GW Instek网站下载 
www.gwinstek.com 
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FAQ 
 

• 输入信号但屏幕无显示 
• 如何查看安装的选配件 
• 频谱分析仪性能与规格不符 

输入信号但屏幕无显示 
 

运行自动设置(Autoset)，使 GSP-930 以最好的显示刻度显示目标信

号。按 Autoset 键，然后按自动设置[F1]。详情见 55 页。 

如何查看安装的选配件 
 

从系统信息窗口检查选配件的安装情况。按 System 键 → 系统资讯

[F1]。详情见 100 页。 

频谱分析仪性能与规格不符 
 

确保仪器至少开机 30 分钟，且环境温度在+20°C~+30°C 范围内。 

更多信息，请联系您当地经销商或 GWInstek      
www.gwinstek.com / marketing@goodwill.com 
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附录 

更换时钟电池 
 

背景 系统时钟和唤醒时钟使用一个钮扣电池。 

 电池类型: CR2032, 3V, 210mAh 

连接  1. 关闭 GSP-930，取下电池盖和电

池 

 

 2. 更换同类型和同规格的电池 
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词汇缩略语 
 

缩略语 含义 
3GPP 第三代合作伙伴项目 
ACPR 邻近通道功率比 
BS 基站 
CF 中心频率 
CH BW 通道带宽 
CH SPC 通道间隔 
CNR 载波噪音比 
CSO 复合二次差异 
CTB 复合三次差异 
DANL 显示平均噪声电平 
Def. 默认值 
DL 下行链路 
DSSS-OFDM 直接序列扩展频谱-正交频分复用 
EMI 电磁干扰 
ERP-CCK 物理层扩展率-补码键控 
ERP-DSSS 物理层扩展率-直接序列扩频调制 
ERP-OFDM 物理层扩展率-正交频分复用 
ERP-PBCC 物理层扩展率-数据包二进制卷积代码 
ETSI 欧洲电信标准学会 
FDD 频分双工 
IF 中频 
LOI 本机振荡器 
LPF 低通滤波器 
LXI LAN对仪器的扩展 
OCBW 占用带宽 
PSD 功率谱密度 
RBW 分辨率带宽 
REF 参考值 
SEM 频谱辐射屏蔽 
SINAD 信号噪声和失真比 
TDD 时分双工 
TG 跟踪源 
TOI 三阶交调 
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UE 用户设备 
UP 上行链路 
VBW 视频带宽 
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GSP-930默认设置 
默认设置即频谱分析仪的出厂设置(功能设置/测试设置)。 

 

频率   
 中心频率: 1.5GHz 起始频率: 0Hz 
 停止频率: 3GHz CF步进: 自动 
 频率偏移: 0Hz  
扫宽 
 扫宽: 3GHz  
幅值 
 参考电平: 0.00dBm 衰减: 自动 
 刻度/格: 10 刻度类型: 对数 
 刻度: 关闭 Y轴: dBm 
 参考电平偏移: 0.00dBm 校准: 关闭 
 输入阻抗 :50Ω 输入阻抗校准: 0.000dB 
 前置放大: 绕开  
自动设置 
 振幅下限: 自动 扫宽: 自动 
BW/Avg 
 RBW: 自动 VBW: 自动 

 VBW/RBW: N/A 平均: 关闭 

 平均功率: 对数功率 电磁干扰滤波器: 关闭 
扫描 

 扫描时间: 自动 扫描: 持续 

 门控扫描: 关闭 门控延迟: 50ms 

 门控长度: 540ms  
轨迹 

 激活轨迹: 轨迹 1 轨迹类型: 清除&写入 

 轨迹运算: 关闭 检测: 自动, 标准检波 
显示 

 视窗设置: 频谱 LCD亮度: 高 

 LCD背光: 开启 显示线, -50.0dBm, 关闭 
测量 
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 ACPR: 关闭 OCBW: 关闭 
 调幅分析: 关闭 调频分析: 关闭 
 耳机输出: 关闭 NdB带宽: 关闭 
 相位抖动: 关闭 频谱辐射屏蔽: 关闭 
 TOI: 关闭 CNR/CSO/CTB: 关闭 
限制线 
 限制线: 关闭 通过/失败测试: 关闭 
序列 
 序列关闭  
触发 
 自由运行  
文档 
 类型: 全部 排序: 名称 
快速保存 
 类型: 屏幕截图 数据源: 常规 
保存 
 类型: 屏幕截图 数据源: 常规 
调取 
 类型: 状态 目标位置: 本地状态 
标记 
 标记: 关闭 数据源: 常规 
Marker-> 
 N/A  
峰值搜索 
 峰值追踪: 关闭 峰值偏差: 10dB 
 峰值阈值: -50dBm 峰值列表: 关闭 
模式 
 模式: 频谱  
系统 
 语言: 依区域 开机: 预设 
 预设类型: 出厂设置 报警输出: 关闭 

 
选配 
跟踪源: 关闭 

远程接口设置 
GPIB地址: 2 
LAN: DHCP 
RS232波特率: 115200 
USB模式: 主机 
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菜单树 

幅值 
 

Ref Level
-30 dB

Amplitude

Attenuation
10dB

Auto Man

Scale/Div
10 5     2     1

Scale Type
Log Lin

Scale
On Off

Scale Pos.
Left Cent. Right

More
1/2

Y Axis>
dBm

RefLvlOffset
0.000dB

Correction>

Input Z
50 75

Input Z Cal
0.000dB

Preamp
Auto     Bypass

Return
2/2

dBm

dBmV

dBuV

Watts

Volts

Select
Correction>

1

Correction
On               Off

Edit>

Save
Correction

Delete 
Correction

Return

Correction 1

Correction 2

Correction 3

Correction 4

Correction 5

Point Num
15

Frequency
1.2345 GHz

Gain Offset
10.00 dB

Delete Point

Return
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dBm

dBmV

dBuV

Watts

Volts

dBm

W

mW

nW

pW

dBmV

V

mV

uV

dBm

dBuV

V

mV

uV

dBm

W

mW

uW

nW

pW

dBm

V

mV

uV

dBmV

dBuV

dBm

Y Axis>
dBm
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频率, 扫宽, 自动设置, 带宽平均, 扫描 
 

Center Freq
1.2345GHz

Frequency

Start Freq
1.2345GHz

Stop Freq
1.2345GHz

CF Step
1.00000MHz

Auto Man

Freq Offset
0.00Hz

Span
1.2345GHz

Full Span

Zero Span

Last Span

Autoset

Amp. Floor
-80.00dBm

Auto Man
Span

3.000000MHz
Auto Man

RBW
1MHz

Auto Man
VBW

1MHz
Auto Man

VBW/RBW
1.00000

Average
20

On               Off

Average Type>
Log Power

EMI Filter
On               Off

LOG Power

Volt Average

Power Average

Sweep Time
50.00 ms

Auto Man

Sweep Single

Sweep Cont

Gated Sweep
Mode

On Off

Gate Delay
50.0 ms

Gate Length
540 ms

Span Autoset

BW/Avg Sweep
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限制线 
 

Edit
Select Limit>

Pass/Fail
Test>

Limit Line>
1

Point by Point>

Trace Data to
Limit Line>

Mkr Data to
Limit Line>

Save Limit Line

Delete Limit
Line

Return

Point Num
1

Frequency
0Hz

Limit 0.00dBm

Delete Point

Return

High Limit>
Off

Low Limit>
Off

Pass Criterion
All-In Man-In

Min-In

Pass/Fail Test
On               Off

Return

Limit 1

Limit 2

Limit 3

Limit 4

Limit 5

OFF

Point Num
1

Mkr Data to
Point

Limit Offset

Return

Limit
Line

Limit 1

Limit 2

Limit 3

Limit 4

Limit 5

Create Limit Line
Now

Limit Offset
0.000dB

Return
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触发, 序列 
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轨迹, 显示 
 

Select Trace>
1

Clear & Write

Max Hold
-130.0dBm

Min Hold 

View

Blank

More
1/2

Trace Math>

Detection>
Normal

Auto Man

Return

TR1>
Trace 2

TR2>
Trace 2

Power Diff
TR1-TR2

Log Diff
-50.00dBm

TR1-TR2+Ref
Log Offset

0.00dB
TR1 + Offset

OFF

Return

Window Setup>

LCD Brightness
Hi Mid      Lo

LCD Backlight
On Off

Display Line
-50.00dBm

On Off

Spectrum

Split Spectrum>

Spectrogram

Topographic

Spectrogram
+

Spectrum
Topographic

+
Spectrum

Return

Active Win.
Upper Lower

Alternate
Sweep

Return

Trace

Trace 1

Trace 2

Trace 3

Trace 4

Trace 4

Auto

Normal

Peak +

Peak -

Sample

Average

Display
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标记 
 

Select Marker>
1

on off

Normal

Delta>

Function>

All Off

More 
1/2

Marker 1

Marker 2

Marker 3

Marker 4

Marker 5

Marker 6

Delta

Move Ref

Move Delta

Move Pair 
Span

Move Pair 
Center

Return

Marker Trace>
Trace 1

Auto Man

Marker Table
On               Off

Return 2/2

Auto

Trace 1

Trace 2

Trace 3

Trace 4

Freq  Counter>

Marker Noise
On               Off

Return

Freq Counter
On               Off

Resolution
1kHz

Auto Man

Return

Marker
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峰值搜索, 标记-> 
 

Peak Search

Mkr>Center

Next Peak

Next Peak Right

Next Peak Left

Min Search

More 
1/2

Peak Track
On Off

Peak Excursion
10.00dB

Peak Threshold
-50.00dBm

On                 Off

Peak Table>

Return
2/2

Peak Table
On Off

Peak Sort
Freq Amp

Return

Mkr>Center

Mkr>Start

Mkr>Stop

Mkr>CF Step

Mkr>RefLvl

Peak 
Search

Marker->
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系统 
 

System 
Information

Error message>

Language>
English

Date/Time>

Pwr On/preset>

Alarm Output
On Off

More
1/2

Show Error
message

Prev Page

Next Page

Clear Error
queue

Return

Power On
Last Preset

Preset Type>

Save User 
Preset

Return

Option>

Rmt Interface
Config>

Upgrade

Service>

Return
2/2

Set Date>

Set Time>

Wake-Up Clock
Edit>

Return

Year
2011

Month
10

Day
5

Return

Factory

Factory Preset

Hour
5

Minute
11

Second
52

Return

System
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Tracking 
Generator>

Return

TG
On Off

TG Level
0.00dBm

TG Lvl Offset
0.000dB

TG Lvl Step
0.000dB

Auto Man
Power Sweep

0.000dB
On Off

Normalize>

Return

Exe. Norm.

Norm Ref Lvl
0.000dB

Nor Ref Pos.
10

Norm
On Off

Return

From: System> More 1/2
>Option

300

600

1200

2400

4800

9600

More 1/2 

19200

38400

57600

115200

Return

From: System>More 1/2> 
Rmt Interface Config> 
RS232 Baud Rate
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模式, 文档 
 

Spectrum

Power Meter

Power Unit
dBm mV

Frequency
3 MHz

Sensor Mode
LowNoise Fast

Pass/Fail
Test>

Trigger 
Free Ext

Max/Min Hold
On Off

Return

High Limit
-10 dBm

Low Limit
-10 dBm

Pass Fail Test
On               Off

Return

File Explorer>
Local

Type>
All

Sort by
Name Date

Copy to>

Delete>

Rename>

Move to>

Media>
Local

Copy Now

Return

Media>
Local

Move Now

Return

Local

USB

SD Card

Mode

File
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All

State

Trace

Screen

Limit Line

Correction

More 1/2

Sequence

Power Meter

Return 2/2

Delete Now

Delete Warning
Don’t Ask Ask

Return

ABCDE

FGHIJ

KLMNO

PQRST

UVWXY

Z

Return

A

B

C

D

E

Lowercase

Return

a

b

c

d

e

Return

From: File>Type From: File>Delete

From: File>Rename

.sta

.tra

.jpg

.cor

.seq

.pmet
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存储 
 

(模式 = 功率计) 

See: File>Rename

According to type:

Save To>
Local

Type>
State

Data Source>
Local State

PMET
Record Option>

Name>

Record Stop

Record Now

State

Screen

Power Meter

Record Stop
00: 00: 00

Record Step
1 s

Return

Power Meter
State Local State Normal

Save Toner

Hour
06

Minute
07

Second
08

Return

See: Save>Save To>Local

Save
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Register 1

Register 2

Register 3

Register 4

Register 5

Register 6

More 1/2

Register>

Local

USB

SD Card

Return

From: Save>Save To>Local 
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(模式 = 频谱) 
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调取 
 

(模式 = 功率计) 

According to type:

Recall From>
Local

Type>
State

Destination>
Local State

Recall Now

State

Power Meter

Local State Power Meter

Recall

.pmet

.sta

Register 1

Register 2

Register 3

Register 4

Register 5

Register 6

More 1/2

Register>

Local

USB

SD Card

Return
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(模式 = 频谱) 

Recall From>
Local

Type>
Trace

Destination>
Trace 1

Recall Now

State

Trace

Line Line

Correction

Sequence

Local State Trace 1

Trace 2

Trace 3

Trace 4

Limit 1

Limit 2

Limit 3

Limit 4

Limit 5

Recall

Correction 1

Correction 2

Correction 3

Correction 4

Correction 5

Sequence 1

Sequence 2

Sequence 3

Sequence 4

Sequence 5

.sta

.tra

.cor

.lmt

.seq

Register 1

Register 2

Register 3

Register 4

Register 5

Register 6

More 1/2

Register>

Local

USB

SD Card

Return
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测量 
 

Channel 
Analysis>

Demod>

NdB
Bandwidth>

Phase
Jitter>

SEM>

TOI>

CNR/CSO/CTB>

ACPR Setup>

ACPR
On               Off

OCBW Setup>

OCBW
On               Off

Channel
Move Up

Channel
Move Down

Return

Main CHBW
2.000000MHz

Main CH 
HLimit

0.00dBm
Main CH 

LLimit
0.00dBm

CH SPC
2.000000MHz

ADJCH
Setup>

Def. Help
On Off

Return

Meas

See: Meas>Demod

Phase Jitter
On              Off

Start Offset
0Hz

Stop Offset
0Hz

Return

NdB BW
On              Off

N dB
0.000dB

Return

CHBW
2.000000MHz

CH SPC
2.000000MHz

OCBW %
90.0%

OCBW SPAN
3.000000MHz

Return

Select Adj Ch>
1

on off

ADJ CHBW
2.000000MHz

ADJ CH Offset
2.000000MHz

ADJ CH
H Limit

0.00dBm

ADJ CH
L Limit

0.00dBm

Return

AdjCh1

AdjCh2

AdjCh3
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AM Analysis>

FM Analysis>

Sound>

Return

Earphone Out
On Off

Volume
10

Digital Gain 
Control

0.000dB

Demod Type
AM FM

Return

TOI
On Off

Reference 
Lower Upper

Limit -
30.00dBm

Pass/Fail Test
On Off

Return

Setup>
CNR

CNR
On Off

CNR
CH SPC

6.000 MHz

Channel 
Move Down

Channel 
Move Up

Return

CNR>

CSO

CTB>

Return

Noise Marking
Min ΔMarker

Return

Restart

Return

From: Measure>Demod From: Measure>TOI

From: Measure>CNR/CSO/CTB
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IF Bandwidth
300kHz

LPF>
Bypass

Time Axis>

Depth Axis>

AF Trigger>

Return

Bypass

3kHz

5kHz

23kHz

150kHz

200kHz

Ref. Value
0.0ns

Ref. Pos
5

Scale/Div
10.00ms

Auto Scale
On Off

Return

Ref. Value
30Hz

Ref. Pos
5

Scale/Div
10 %

Auto Scale

Return

Free Run

Edge Slope
Rising Falling

Trigger Mode
Nor. Sgl.  Cont.

Trigger Level
10 %

Trigger Delay
50 ms

Run Now

Return

From: Measure>Demod>AM 
Analysis

Decimation 
frequency*

AM Analysis
On Off

Setup>

Min/Max Reset

 
* 见 115页低通滤波器带宽 
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IF Bandwidth
300kHz

LPF>
Bypass

Time Axis>

Deviation Axis>

AF Trigger>

Return

Bypass

3kHz

5kHz

23kHz

150kHz

200kHz

Ref. Value
0.0ns

Ref. Pos
5

Scale/Div
10.00ms

Auto Scale
On Off

Return

Ref. Value
30Hz

Ref. Pos
5

Scale/Div
10 Hz

Auto Scale

Return

Free Run

Edge Slope
Rising Falling

Trigger Mode
Nor. Sgl.  Cont.

Trigger Level
10 Hz

Trigger Delay
50 ms

Run Now

Return

From: Measure>Demod>FM 
Analysis

Decimation 
frequency*

FM Analysis
On Off

Setup>

Min/Max Reset

 
* 见 118页低通滤波器带宽 
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SEM Setup>
3GPP

SEM
On Off

Def. Help
On Off

Return

3GPP>

802.11b>

802.11g>

802.11n>

802.16n>

User Define>

Return

Meas Type
Total pwr Ref

Ref. Channel>

Offset/Limit>

Return

Chan Integ BW
3.84 MHz

Chan Span
3.96 MHz

RBW
10kHz

Auto Man
Total Pwr Ref

-74.3dBm
Auto Man

Return

Duplexing
Table

FDD TDD

FDD Setup>

TDD Setup>

Return

Meas Type
PSD Ref

Ref. Channel>

Offset/Limit>

Return

From: Measure>SEM

From: Measure>SEM>3GPP> 
REF. Channel

From: Measure>SEM>3GPP> 
Offset/Limit
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Transmission
BS UE

Max Out Pwr>
P>=43

Additional Max 
Out Pwr>

None

Add. Limits
None

Min Offset/Limit
Value>

Return

P>=43

39<=P<43

31<=P<39

P<31

None

6<=P<=20

P<6

Offset
1 2    3    4   5

On Off

Start Freq
27 MHz

Stop Freq
27MHz

RBW

More 1/2

Return

Offset
1 2    3    4   5

Abs Start
-22 dBm

Abs Stop
-22dBm

Return 
2/2

None

Band II

Band IV

Band V

Band X

Band XII

More 1/2

Band XIII

Band XIV

From: Measure>SEM>3GPP> 
Offset/Limit>FDD Setup

BS Mode
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None

Band II

Band IV

Band V

Band X

Band XII

More 1/2

Band XIII

Band XIV

Transmission
BS               UE

Add. Limits
None

Min Offset/Limit
Value>

Return

Offset
1 2    3    4   5

Start Freq
27 MHz

Stop Freq
27MHz

RBW

More 1/2

Return

Offset
1 2    3    4   5

Abs Start
-22 dBm

Abs Stop
-22dBm

Rel Start
-35dBc

Rel Stop
-50dBc

Return

From: Measure>SEM>3GPP> 
Offset/Limit>FDD Setup

UE Mode
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Transmission
BS               UE

Chip Rate
3.84M 1.28M

7.68M

Min Offset/Limit
Value>

Return

Offset
1 2    3    4   5

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW
3MHz

More 1/2

Return

Offset
1 2    3    4   5

Rel Start
-22dBm

Rel Stop
-22dBm

Return

P>=34

26<=P<34

P<26

P>=43

39<=P<43

31<=P<39

P<31

From: Measure>SEM>3GPP> 
Offset/Limit>TDD Setup Chip Rate = 3.84/7.68M

Chip Rate = 1.28M

Transmission
BS UE

Chip Rate
3.84M 1.28M

7.68M

Max Out Pwr>
P>=43

Min Offset/Limit
Value>

Return

Offset
1 2    3    4   5

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW
3MHz

More 1/2

Return

Offset
1 2    3    4   5

Abs Start
-22dBm

Abs Stop
-22dBm

Return

From: Measure>SEM>3GPP> 
Offset/Limit>TDD Setup

BS 
Mode

UE 
Mode
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From: Measure>SEM>802.11g>
Offset/Limit>Min Offset/Limit

802.11g modulation=OFDM

Offset
1 2

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW

More 1/2

Return

Offset
1 2

Rel Start
-22dBc 

Rel Start
-22dBc 

Return

Offset
1 2      3     4

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW

More 1/2

Return

From: Measure>SEM>802.11g>
Offset/Limit>Min Offset/Limit

802.11g modulation=DSSS

Offset
1 2      3     4

Rel Start
-22dBc 

Rel Start
-22dBc 

Return
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Absolute

Relative

Abs AND Rel

Abs OR Rel

Meas Type>
Total Pwr Ref

Ref. Channel>

Offset/Limit>

Return

Total Pwr Ref

PSD Ref

Chan Integ BW
3.84MHz

Chan Span
3.96MHz

RBW
10kHz

Auto Man
Total Pwr Ref

-74.3dBm
Auto Man

Return

Offset
1 2   3    4    5

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW
10kHz

Auto Man

More 1/2

Return

Offset
1 2   3    4    5

Abs Start
-22dBm

Abs Stop
-22dBm

Rel Start
-22dBc

Rel Stop
-22dBc

Couple Man

Fail Mask>
Absolute

Return

From: Measure>SEM> 
User Define>
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GSP-930规格 
此规格适用于 20˚C~30˚C 的环境温度，GSP-930 至少热机 30 分钟，

除非另行说明。 

频率 
 

频率 
 范围 9 kHz~3.0 GHz  

分辨率 1 Hz  
频率参考 
 精确度 ±[(上一次校准的有效期 X 老化率) + 频率温度稳

定度 + 电源电压稳定度 
老化率 ±2 ppm max. 上一次调整后的一年 

 频率温度稳定度 ±0.025 ppm 0~50 °C 
 电源电压稳定度 ±0.02 ppm  
频率读值精度 
 起始, 停止, 中心, 

标记 
±(标记频率显示 X 频率参考精度 + 10% x RBW + 频
率分辨率 1) 

扫描点 601 扫宽 > 0 
6~601 扫宽 = 0 

标记计频器 
 分辨率 1 Hz, 10 Hz, 100 Hz, 1 kHz 

精确度 ±(标记频率显示 X 频率参

考精度 + 计数器分辨率) 
RBW/Span≥0.02 ; 
Mkr至 DNL电平>30 dB 

扫宽 
 范围 0 Hz (零扫宽), 100 Hz~3 GHz  
 分辨率 1 Hz  
 精确度 ± 频率分辨率 1  
相位噪声 
 载波偏移  Fc =1 GHz; RBW = 1 kHz, VBW 

= 10 Hz; 
平均 ≥ 40 

10 kHz <-88 dBc/Hz 典型值 2 
100 kHz <-95 dBc/Hz 典型值 
1 MHz <-113 dBc/Hz 典型值 

分辨率带宽(RBW)滤波器 
 滤波器带宽 10 Hz~3 kHz，1-3-10步进 -3dB带宽 

总计: 6个档位 
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10 kHz~1 MHz，10%步进增加 -3dB带宽; 
最小 RBW = 10 kHz @零
扫宽 
总计: 49个档位 

200 Hz, 9 kHz, 120 kHz -6dB带宽（EMI滤波器

） 
精确度 ± 8%, RBW ≥ 750 kHz 标称 3 

± 5%, RBW < 750 kHz 标称 
形状因子 < 4.5:1 标称带宽比: -60dB:-3dB 

视频带宽(VBW)滤波器 
 滤波器带宽 1 Hz~1 MHz    1-3-10步进 -3dB带宽 
[1] 频率分辨率 = 扫宽/(扫描点数 - 1) 
[2] 本数据表里的典型规格是指，超过 20~30 °C的温度范围，80%的单位性能可展

现，95%的可靠性，不在产品保修范围内 
[3] 标称值显示的是预期性能，不在保修范围内 

幅值 
 

幅值范围 
 测量范围 100 kHz~1 MHz 显示平均噪声电平

(DANL)~18 dBm 
1 MHz~10 MHz DANL~21 dBm 
10 MHz~3 GHz DANL~30 dBm 

衰减器 
 输入衰减范围 0~50 dB, 1 dB步进 自动或手动设置 
最大安全输入电平 
 平均总功率 ≥ +33 dBm 输入衰减器 

≥10 dB 
 直流电压 ± 50 V  
1 dB增益压缩 
 第一混频器的总

功率 
> 0 dBm 典型;Fc  ≥ 50 MHz; 前置

放大器关闭 
 在前置放大处总

功率 
> -22 dBm 典型;Fc  ≥ 50 MHz; 前置

放大器开启 
   混频器功率电平

(dBm)= 输入功率(dBm)-
衰减值(dB) 

显示平均噪声电平(DANL) 
 前置放大器关闭 0 dB衰减; RBW 10 Hz; VBW 10 Hz; 扫宽 500 Hz; 参考电平 

=  -60dBm; 轨迹平均 ≥ 40 
 9 kHz~100 kHz < -93 dBm, 标称 
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 100 kHz~1 MHz < -90 dBm - 3 x (f/100 kHz) dB 
 1 MHz~10 MHz < -122 dBm 
 10 MHz~3 GHz < -122 dBm 
 前置放大器开启 0 dB衰减; RBW 10 Hz; VBW 10Hz; 扫宽 500 Hz;  参考电平 

=  -60dBm; 轨迹平均 ≥ 40 
 100 kHz~1 MHz < -108 dBm - 3 x (f/100 kHz) dB 

标称  1 MHz~10 MHz < -142 dBm 
 10 MHz~3 GHz < -145 dBm + 3 x (f/1 GHz) dB 
电平显示范围 
 刻度 对数, 线性  
 单位 dBm, dBmV, dBuV, V, W  
 标记电平读值 0.01 dB 对数刻度 
  参考电平的 0.01 % 线性刻度 
 电平显示模式 轨迹, 拓扑, 光谱 单/分割视窗 
 轨迹数 4  
 检波方式 正向峰值, 负向峰值, 采样,  

正常, RMS(非视频) 
每个轨迹可分别设置 

 轨迹功能 清除&写入, 最大值/最小

值保持, 查看, 隐藏, 平均 
 

绝对幅值精度 
 绝对点 中心频率=160 MHz ; RBW 10 kHz; VBW 1 kHz; 扫宽 100 kHz; 

对数刻度;  1 dB/div; 峰值侦测; 20~30°C; 信号 0 dBm 
 前置放大器关闭 ± 0.3 dB 参考电平 0 dBm; 10 dB 

RF衰减 
 前置放大器开启 ± 0.4 dB 参考电平-30 dBm; 0 dB 

RF衰减 
频率响应 
 前置放大器关闭 衰减: 10 dB; 参考: 160 MHz; 20~30°C 
 100 kHz~2.0 GHz ± 0.5 dB  
 2.0GHz~3.0 GHz ± 0.7 dB  
 前置放大器开启 衰减: 0 dB; 参考: 160 MHz; 20~30°C 
 1 MHz~2.0 GHz ± 0.6 dB  
 2.0GHz~3.0 GHz ± 0.8 dB  
衰减转换的不确定性 
 衰减器设置 0~50 dB，1 dB步进  
 不确定性 ± 0.15 dB 参考: 160 MHz, 10dB衰减 
RBW滤波器开关的不确定性 
 10 Hz~1 MHz ± 0.15 dB 参考: 10 kHz RBW 
测量电平的不确定性 
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 整体幅值精度 ± 1.5 dB 20~30°C; 频率 > 1 MHz; 信号输入 0~ -50 
dBm; 参考电平 0~ -50 dBm;  
输入衰减 10 dB;   
RBW  1 kHz;  
VBW 1 kHz; 校准后; 前置放大器关闭 

 ± 0.5 dB 典型 
离散响应 
 二次谐波截取  前置放大器关闭; 输入信号-30dBm; 0 

dB衰减 
 +35 dBm 典型; 10 MHz < fc < 775 MHz 
 +60 dBm 典型; 775 MHz ≤ fc < 1.5 GHz 
 三阶截取   前置放大器关闭; 输入信号-30dBm; 0 

dB衰减 
 > 1dBm 300 MHz~3 GHz 
 输入伪噪声 < -60 dBc 第一个混频器的信号电平 -30 dBm; 

20~30°C 
 残余反应(固有) <-90 dBm 输入终端; 0 dB衰减; 前置放大器关

闭 

扫描 
 

扫描时间 
 范围 22 ms~1000 s Span > 0 Hz 
 50 us~1000 s Span = 0 Hz; 最小分辨

率 = 10 us 
 扫描模式 持续; 单次  
 触发源 自由运行; 视频; 外部  
 触发斜率 上升沿或下降沿  

RF前置放大器 
 

 频率范围 1 MHz~3 GHz  
 增益 18 dB 标称 
  (标准安装) 

前面板输入/输出 
 

RF输入 
 接口类型 N-type母头  
 阻抗 50Ω，标称  
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 VSWR <1.6 :1 300 kHz~3 GHz; 输入衰

减器 ≥ 10 dB 
选配电源 
 接口类型 SMB公头  
 电压/电流 DC +7V / 500 mA 最大 带输出短路保护 
USB Host 
 接口类型 A plug  
 协议 2.0版本 支持全/高/低速 
MicroSD卡槽 
 协议 SD 1.1  
 支持  microSD, microSDHC 最大支持 32GB容量 

后面板输入/输出 
 

参考输出 
 接口类型 BNC母头  
 输出频率 10 MHz  
 输出幅值 3.3V CMOS  
 输出阻抗 50Ω  
参考输入 
 接口类型 BNC母头  
 输入参考频率 10 MHz  
 输入幅值 -5 dBm~+10 dBm  
 频率锁定范围 在输入参考频率的± 5 ppm

内 
 

报警输出 
 接口类型 BNC母头; 集电极开路  
触发输入/门控扫描输入 
 接口类型 BNC母头  
 输入幅值 3.3V CMOS  
 开关 自动选择功能  
LAN TCP/IP接口 
 接口类型 RJ-45  
 Base 10Base-T; 100Base-Tx; Auto-MDIX 
USB Device 
 接口类型 B plug 仅用于远程控制; 支

持 USB TMC 
 协议 2.0版本 支持全/高速 
中频输出 
 接口类型 SMA母头  
 阻抗 50Ω 标称 
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 中频频率 886 MHz 标称 
 输出电平 -25 dBm 10 dB衰减; RF输入: 0 

dBm @ 1 GHz; 
耳机输出 
 接口类型 3.5mm立体声插孔,  

有线单声道操作 
 

视频输出 
 接口类型 DVI-I (集成模拟和数字) , 单

链接 
转接头兼容 VGA或
HDMI标准 

RS232接口 
 接口类型 D-sub 9-pin母头 Tx,Rx,RTS,CTS 
GPIB接口(选配) 
 接口类型 IEEE-488总线连接  
交流电源输入 
 电源 AC 100 V~240 V, 50 / 60 Hz 自动选择范围 
电池组(选配) 
 电池组 6 cells, 可充电锂离子电池, 

3S2P 
UN38.3认证 

 电压 DC 10.8 V  
 容量 5200 mAh / 56Wh  

常规 
 

 内部数据存储 16 MB 标称  
 功耗 <65 W  
 热机时间 < 30分钟  
 温度范围 +5 °C ~ +45 °C 操作温度 
 -20 °C ~ +70 °C 存储温度 
 重量 4.5 kg (9.9 lb) 全配(标配+TG+GPIB+电池) 
 尺寸 350（W）x 213（H）210x 

105.7（D） (mm) 
 

  13.8（W） x8.3（H） x 
3.9 （D）(ince) 
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跟踪源(选配) 
 

 频率范围 100 kHz~3 GHz  
 输出功率 -50 dBm~0 dBm     0.5 dB步进 
 绝对精度 ± 0.5 dB @160 MHz, -10 dBm, 源衰减 10 

dB, 20~30°C 
 输出平坦度 参考 160 MHz, -10 dBm 
 100 kHz~2 GHz ± 1.5 dB 
 2GHz~3 GHz ± 2 dB 
 输出电平转换的不

确定性 
± 0.8 dB 参考-10 dBm 

 谐波 < -30 dBc 典型, 输出电平 = -10 dBm 
 反向功率 +30 dBm 最大.  
 接口类型 N-type母头  
 阻抗 50Ω 标称 
 输出驻波比(VSWR) < 1.6:1 300 kHz~3 GHz, 源衰减 ≥ 12 dB 

USB功率传感器(选配) 
 

 类型 平均功率传感器 型号: PWS-06 
 表接口 USB线接到 GSP-930前面板的 USB Host 
 接口类型 N-type公头, 50Ω标称 
 输入驻波比(VSWR) 1.1: 1 典型 
 1.3: 1 最大 
 输入频率 1 ~6200 MHz  
 传感电平 -32~+20 dBm  
 最大输入损坏功率 ≥ 27 dBm  
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 功率测量不确定性

@ 25 °C 
-30 dBm~+5 dBm: 
1 MHz~3GHz: ±0.10 dB典型 
3 GHz~6 GHz: ±0.15 dB典型 
+5 dBm~+12 dBm: 
1 MHz~3GHz: ±0.15 dB典型 
3 GHz~6 GHz: ±0.15 dB典型 
+12 dBm~+20 dBm: 
1 MHz~3GHz: ±0.20 dB典型 
3 GHz~6 GHz: ±0.20 dB典型 

 
  
±0.30 dB 最大. 
 
±0.30 dB 最大. 
 
 
±0.30 dB 最大. 
 
±0.30 dB 最大. 
 
 
±0.40 dB 最大. 
 
±0.40 dB 最大. 

 功率测量不确定性

@ 0~25 °C 
-30 dBm ~ +5 dBm: 
1 MHz~3GHz: ±0.25 dB典型 
3 GHz~6 GHz: ±0.25 dB典型 
+5 dBm ~ +12 dBm: 
1 MHz~3GHz: ±0.20 dB典型 
3 GHz~6 GHz: ±0.20 dB典型 
+12 dBm~ +20 dBm: 
1 MHz~3GHz: ±0.35 dB典型 
3 GHz~6 GHz: ±0.30 dB典型 

 
  
 

 线性度@ 25 °C ±3 %  
 测量速度 100 ms低噪声模式 

30 ms快速模式 
典型 
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 GSP-930尺寸 
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Declaration of Conformity 
 

We 

GOOD WILL INSTRUMENT CO., LTD. 
No. 7-1, Jhongsing Rd, Tucheng Dist., New Taipei City 236, Taiwan  

GOOD WILL INSTRUMENT (SUZHOU) CO., LTD. 
No. 69 Lushan Road, Suzhou New District Jiangsu, China. 

declare that the below mentioned product 

Type of Product: Spectrum Analyzer 
Model Number: GSP-930 
is herewith confirmed to comply with the requirements set out in the 
Council Directive on the Approximation of the Laws of the Member States 
relating to the Low Voltage Directive (2006/95/EC) and Electromagnetic 
Compatibility (2004/108/EC). 
 
For the evaluation regarding the Electromagnetic Compatibility and Low 
Voltage Directive, the following standards were applied: 
 

◎ EMC 
EN 61326-1 : 
EN 61326-2-1: 
EN 61326-2-2: 

Electrical equipment for measurement, control and 
laboratory use –– EMC requirements (2006) 

Conducted and Radiated Emissions 
EN 55011: 2009+A1: 2010 

Electrostatic Discharge 
EN 61000-4-2: 2009

Current Harmonic 
EN 61000-3-2: 2006+A1: 2009+A2: 2009 

Radiated Immunity 
EN 61000-4-3: 2006+A1: 2008+A2 :2010 

Voltage Fluctuation 
EN 61000-3-3: 2008 

Electrical Fast Transients 
EN 61000-4-4: 2004+A1: 2010 

------------------------- 
Surge Immunity 

EN 61000-4-5: 2006

------------------------- 
Conducted Susceptibility 

EN 61000-4-6: 2009

------------------------- 
Power Frequency Magnetic Field 

EN 61000-4-8: 2010

------------------------- 
Voltage Dips/ Interrupts 

EN 61000-4-11: 2004 

 
Low Voltage Equipment Directive 2006/95/EC 
Safety Requirements 
 

EN 61010-1: 2010 
EN 61010-2-030: 2010 
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Center frequency .......................... 39 
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Activation .................................... 173 
Data logging ................................ 175 
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Safety instruction ............................ 4 

Power up ................................ 26, 27 
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